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前言

简介

本章包含使用 MPLAB PM3 前需要了解的有用的一般信息。内容包括：

• 文档编排

• 本指南使用的约定

• 保修登记

• 推荐读物

• Microchip 网站

• 开发系统变更通知客户服务

• 客户支持

客户须知

所有文档均会过时，本文档也不例外。 Microchip 的工具和文档将不断演变以满足客户的需求，因此
实际使用中有些对话框和 / 或工具说明可能与本文档所述之内容有所不同。请访问我们的网站
（www.microchip.com）获取最新文档。

文档均标记有 “DS”编号。该编号出现在每页底部的页码之前。 DS 编号的命名约定为
“DSXXXXXA”，其中 “XXXXX”为文档编号，“A”为文档版本。

欲了解开发工具的最新信息，请参考 MPLAB® IDE 在线帮助。从 Help （帮助）菜单选择 Topics
（主题），打开现有在线帮助文件列表。
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文档编排

本文档介绍了如何使用 MPLAB PM3 开发工具在目标电路板上仿真和调试固件。本手
册的内容编排如下：

• 第 1 章 MPLAB PM3 概述——描述 MPLAB PM3 及其工作原理。

• 第 2章 安装MPLAB PM3——描述如何安装MPLAB PM3的硬件和软件。说明如何
设置 MPLAB IDE 及 MPLAB PM3，使它们配合工作，以及如何从 MPLAB IDE 启
动 MPLAB PM3。

• 第 3 章 教程——包含对校准存储器、存储器和其他 PICmicro® MCU 器件编程的若
干示例 （教程）。

• 第 4 章 通过 MPLAB IDE 使用 MPLAB PM3——一步步指导用户如何通过 MPLAB 
IDE 来使用 MPLAB PM3，从而对器件进行编程、读取和校验。

• 第 5 章 以独立模式使用 MPLAB PM3——指示用户如何以独立模式使用 MPLAB 
PM3。

• 第 6 章 使用 MPLAB PM3 卡——指示用户如何使用 MPLAB PM3 卡。

• 第7章 MPLAB PM3—MPLAB IDE参考信息——说明了可通过MPLAB PM3命令行
接口使用的命令及错误消息。

• 第 8 章 独立模式参考信息——说明了可通过 MPLAB PM3 LCD 使用的命令。

• 第 9 章 MPLAB PM3 卡参考信息——说明了 MPLAB PM3 卡专用的命令。

• 附录 A 硬件规范——说明如何将 MPLAB PM3 连接到通信端口。提供清洁 MPLAB 
PM3 插座模块的指示。

• 附录 B 疑难解答——提供解决常见问题的信息。
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本指南使用的约定

本手册采用以下文档约定：

文档约定

说明 涵义 示例

Arial 字体：

斜体字 参考书目 MPLAB® IDE User's Guide

需强调的文字 ... 仅有的编译器 ...
首字母大写 窗口 Output 窗口

对话框 Settings 对话框

菜单选项 选择 Enable Programmer
引用 窗口或对话框中的字段名 “Save project before build”
带右尖括号且有下划线的斜体
文字

菜单路径 File>Save

粗体字 对话框按钮 单击 OK
选项卡 单击 Power 选项卡

N‘Rnnnn verilog 格式的数，其中 N 是
总位数， R 是基数，而 n 代表
一个位。

4‘b0010, 2‘hF1

尖括号 < > 括起的文字 键盘上的按键 按 <Enter>， <F1>
Courier New 字体：

常规 Courier New 源代码示例 #define START

文件名 autoexec.bat

文件路径 c:\mcc18\h

关键字 _asm, _endasm, static

命令行选项 -Opa+, -Opa-

位值 0, 1

常数 0xFF, ‘A’

斜体 Courier New 可变参数 file.o，其中 file可以是任
一有效文件名

方括号 [ ] 可选参数 mcc18 [options] file 
[options]

花括号和竖线： { | } 选择互斥参数； “或”选择 errorlevel {0|1}

省略号 ... 代替重复文字 var_name [, 
var_name...]

表示由用户提供的代码 void main (void)
{ ...
}
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保修登记

请填写随附的保修登记卡 （Warranty Registration Card）并尽快寄出。寄出保修登记
卡的客户将可收到新产品更新信息。临时发布的软件在 Microchip 网站上提供。

推荐读物

本用户指南介绍了如何使用 MPLAB PM3 编程器。下面列出了其他有用的文档。以下
Microchip 文档均已提供，并建议读者作为补充参考材料。

MPLAB PM3 的自述文件 （Readme）
有关使用 MPLAB PM3 的最新信息，请阅读 “Readme for MPLAB PM3.txt”文件
（ASCII 文本文件），该文件位于 MPLAB IDE 安装目录的 Readmes子目录下。自述
文件包含了本用户指南中可能未提供的更新信息和已知问题。

MPLAB PM3 在线帮助

MPLAB® IDE v6.xx 快速入门指南 （DS51281C_CN）

说明如何设置 MPLAB IDE 软件，并用它创建项目和对器件编程。

MPLAB® IDE 用户指南 （DS51519A_CN）

全面描述了 Microchip 的 MPLAB 集成开发环境 （IDE）的安装和功能。

MPASM™ 汇编器、MPLINK™ 目标链接器和 MPLIB™ 目标库管理器用户指南
（DS33014J_CN）

说明如何使用 Microchip 的 PICmicro MCU 汇编器 （MPASM 汇编器）、链接器
（MPLINK 链接器）和库管理器 （MPLIB 库管理器）。

MPLAB IDE 在线帮助

In-Circuit Serial Programming™ (ICSP™) Guide （DS30277）
本文档中的设计指导将帮助您成功进行 ICSP 编程。其中包括硬件设计方面的应用笔记
和 ICSP 编程规范。
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MICROCHIP 网站

Microchip 网站 （www.microchip.com）为客户提供在线支持。客户可通过该网站方便
地获取文件和信息。只要使用常用的因特网浏览器即可访问。网站提供以下信息：

• 产品支持——数据手册和勘误表、应用笔记和示例程序、设计资源、用户指南以及
硬件支持文档、最新的软件版本以及存档软件

• 一般技术支持——常见问题 （FAQ）、技术支持请求、在线讨论组以及 Microchip
顾问计划成员名单

• Microchip业务——产品选型和订购指南、最新Microchip新闻稿、研讨会和活动安
排表、 Microchip 销售办事处、代理商以及工厂代表列表

开发系统变更通知客户服务

Microchip 的客户通知服务有助于客户了解 Microchip 产品的最新信息。注册客户可在
他们感兴趣的某个产品系列或开发工具发生变更、更新、发布新版本或勘误表时，收
到电子邮件通知。

欲注册，请登录 Microchip 网站 www.microchip.com，点击 “变更通知客户
（Customer Change Notification）”服务并按照注册说明完成注册。

开发系统产品的分类如下：

• 编译器——Microchip C 编译器及其他语言工具的最新信息，包括 MPLAB C18 和
MPLAB C30 C 编译器、 MPASMTM 和 MPLAB ASM30 汇编器、 MPLINKTM 和
MPLAB LINK30 目标链接器，以及 MPLIBTM 和 MPLAB LIB30 目标库管理器。

• 仿真器——Microchip 在线仿真器的最新信息，包括 MPLAB ICE 2000 和 MPLAB 
ICE 4000。

• 在线调试器——Microchip 在线调试器 MPLAB ICD 2 的最新信息。

• MPLAB® IDE——关于开发系统工具的Windows®集成开发环境Microchip MPLAB 
IDE 的最新信息，主要针对 MPLAB IDE、 MPLAB SIM 软件模拟器、 MPLAB IDE
项目管理器以及一般编辑和调试功能。

• 编程器——Microchip编程器的最新信息，包括MPLAB PM3和PRO MATE® II器件
编程器以及 PICSTART® Plus 和 PICkit® 1 开发编程器。
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客户支持

Microchip 产品的用户可通过以下渠道获得帮助：

• 代理商或代表

• 当地销售办事处

• 应用工程师 （FAE）
• 技术支持

客户应联系其代理商、代表或应用工程师 （FAE）寻求支持。当地销售办事处也可为
客户提供帮助。本文档后附有销售办事处的联系方式。

也可通过 http://support.microchip.com 获得网上技术支持。
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第 1 章 MPLAB PM3 概述

1.1 简介

本章概述 MPLAB PM3 的功能和要求。本章讨论的主题包括：

• 什么是 MPLAB PM3？
• MPLAB PM3 的功能

• MPLAB PM3 系统组件

• MPLAB PM3 符合 CE 标准

• MPLAB PM3 的用途

• MPLAB PM3 可与 PC 配合工作

• MPLAB PM3 也可不依靠 PC 独立工作

• MPLAB 集成开发环境

• MPLAB 开发工具

1.2 什么是 MPLAB PM3？
MPLAB PM3 是 Microchip 的单片机器件编程器。通过可更换的编程插座模块，
MPLAB PM3 使您可以快速方便地对 Microchip 的所有单片机进行编程。

MPLAB PM3 可在所支持的 Windows 操作系统 （请参见 “Readme for MPLAB 
PM3.txt”文件以查看支持列表）上运行，与 MPLAB IDE 配合使用，也可以作为独立
编程器使用。

请参见 “前言”中的 “推荐读物”，以了解更多信息。

1.3 MPLAB PM3 的功能

MPLAB PM3 可安装在 PC 的串口 （COM 1-4）或 USB 通信端口上。用 MPLAB PM3
可执行以下操作：

• 对器件的程序存储器、配置位、EEPROM 数据存储器、 ID 地址单元和校准数据进

行编程。

• 在目标电路板上使用在线串行编程 （In-Circuit Serial Programming™， ICSP™）

对器件编程，并通过 GO、 PASS 和 FAIL 信号与 MPLAB PM3 接口。

• 检查单片机是否为空白。

• 校验目标单片机中的代码与固件是否匹配。

• 将未代码保护单片机中的代码读取到 MPLAB IDE 的程序存储器窗口，来调试并烧
写到其他器件。

• 用 “带序列号的快速批量编程”（Serial Quick Turn Programming， SQTPSM）文
件将唯一的序列 ID 号烧写到固件中。

• 将环境保存到 MPLAB PM3 卡中。
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1.4 MPLAB PM3 系统组件

MPLAB PM3 器件编程器系统由以下部分组成：

• MPLAB PM3 器件编程器（见图 1-1）
• 模块插座

• 可连接到任何标准 PC 串口的 RS-232 接口电缆

• 可连接到任何标准 PC 端口的 USB 接口电缆

• ICSP 电缆

• 电源

• MPLAB IDE 软件，即包括文本编辑器、项目管理器和用于调试的软件模拟器的集
成开发环境。同时还包括 MPASM 汇编器、 MPLINK 目标链接器和 MPLIB 目标库
管理器。

图 1-1： MPLAB® PM3 器件编程器

1.5 MPLAB PM3 符合 CE 标准

MPLAB PM3 器件编程器是遵照欧盟 CE 电磁兼容标准的电磁兼容要求进行设计、测试
和认证的。欧盟国家设定的这些标准包括限制辐射发射、降低对辐射发射的灵敏度及
降低对静电放电 （ESD）的灵敏度。

注： Microchip 提供了一整套插座模块。可为待编程器件单独订购插座模块。
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1.6 MPLAB PM3 的用途

使用 MPLAB PM3 器件编程器时，您可以通过 PC 主机对 Microchip 的器件编程，也
可以将该器件编程器用作独立的设备。

• MPLAB PM3 易于使用，可灵活地对 Microchip 各种封装类型的器件进行编程。

• 将对MPLAB PM3进行扩展以支持Microchip将来的器件，始终提供最新的编程算法
来支持 Microchip PIC® 单片机器件和其他 Microchip 器件，具体请访问 Microchip
网站 （http://www.microchip.com）。

• 插入可选的 MPLAB PM3 卡之后，可存储并传输用于编程的器件设置。

1.7 MPLAB PM3 可与 PC 配合工作

使用 MPLAB 集成开发环境（IDE）作为接口， MPLAB PM3 成为了 MPLAB IDE 中的
另一种工具，使您能快速编译、测试并调试固件，然后下载到 MPLAB PM3 中以便烧
写到器件中。

1.8 MPLAB PM3 也可不依靠 PC 独立工作

MPLAB PM3 也可不连接 PC，作为独立的器件编程器工作。但是，对操作系统进行更
新还是需要 PC 连接的。MPLAB PM3 的主要编程器功能都可用，包括读取、编程和校
验。

1.9 MPLAB 集成开发环境

MPLAB IDE 桌面提供了开发和调试应用程序的环境。 MPLAB PM3 集成到了 MPLAB 
IDE 中，但您无需 MPLAB IDE 也能使用 MPLAB PM3。
本文档讲述了 MPLAB PM3 器件编程器的基本设置和操作，但并未涵盖 MPLAB IDE
的所有功能。可通过阅读有关 MPLAB IDE 的文档全面了解 MPLAB IDE 的特性和调试
功能。
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1.10 MPLAB 开发工具

MPLAB IDE 集成了多种工具来提供完整的开发环境。

• MPLAB 项目管理器

项目管理器用于创建项目及处理与项目相关的特定文件。使用项目时，只需单击鼠
标一下，就可以重新编译源代码并将其下载到软件模拟器或仿真器中。

• MPLAB 编辑器

MPLAB 编辑器用于创建并编辑源文件、代码和链接描述文件之类的文本文件。

• MPLAB SIM 软件模拟器

软件模拟器用于模拟 PICmicro 单片机的指令执行和 I/O。

• MPLAB ICE 仿真器

MPLAB ICE 仿真器用硬件实时仿真 PICmicro 单片机 （有无目标系统均可）。

• MPASM 通用汇编器 /MPLINK 可重定位链接器 /MPLIB 库管理器

MPASM 汇编器允许在 MPLAB IDE 内汇编源代码。 MPLINK 链接器通过链接由
MPASM 汇编器、 MPLAB C17 和 MPLAB C18 生成的可重定位模块来生成最终的
应用程序。 MPLIB 库管理器可对用户自定义的库进行管理，以便最大程度地重用
代码。

• MPLAB C18 和 MPLAB C30 C 编译器

MPLAB C18 和 MPLAB C30 C 编译器提供基于 ANSI 的高级源代码解决方案。复
杂项目可混合使用 C 和汇编源文件，以使代码具有最快的执行速度和最高的可维
护性。

• MPLAB PM3、 PRO MATE II 及 PICSTART Plus 编程器

用软件模拟器或仿真器开发代码，汇编或编译代码，然后用这些编程器之一对器件
编程。这些都可以通过 MPLAB IDE 来完成。

• 第三方工具

有许多其他公司提供可与 MPLAB IDE 配合工作的 Microchip 产品开发工具。请访
问 Microchip 网站以了解更多信息。
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第 2 章  安装 MPLAB PM3

2.1 简介

本章说明如何安装 MPLAB PM3 的硬件和软件。本章讨论的主题包括：

• 安装 MPLAB PM3 的软件

• 安装 MPLAB PM3 的硬件

• 对 MPLAB PM3 上电

• 为使用 MPLAB PM3 配置 MPLAB IDE

2.2 安装 MPLAB PM3 的软件

如果使用运行 Windows 的 PC， MPLAB PM3 硬件要求以下软件支持：

• MPLAB IDE 软件

• USB 通信驱动程序

2.2.1 MPLAB IDE 软件安装

应按照 《MPLAB® IDE v6.xx 快速入门指南》（DS51281C_CN）中的说明安装
MPLAB IDE 软件。下面将简要概述这一过程。

• 从 CD-ROM 安装：

- 将 MPLAB IDE 的 CD 插入到 CD-ROM 驱动器中。

- 按照屏幕上的说明安装 MPLAB IDE 软件。

• 从 Microchip 网站安装：

- 访问 www.microchip.com 并单击链接转到 “开发工具”页面。

- 单击最新 MPLAB IDE 发行版的链接，并进行下载。

注： MPLAB PM3 控制有两种命令行程序可供选择，它们也随 MPLAB IDE 安
装，名为 PM3CMD 和 Visual PROCMD。



MPLAB® PM3 用户指南

DS51464C_CN 第 12 页  2006 Microchip Technology Inc.

2.2.2 USB 驱动程序安装

首先安装 MPLAB IDE。MPLAB IDE 安装结束时，将弹出 USB 驱动程序安装说明。按
照这些说明安装 USB 驱动程序。

安装说明在 MPLAB IDE 安装目录的以下子目录中：

MPLAB PM3\Drivers\instr.htm

其中 instr.htm取决于您的个人计算机 （PC）的操作系统：

• ddpm398.htm——windows 98
• ddpm3me.htm——windows ME
• ddpm3.htm——windows 2000/XP

2.3 安装 MPLAB PM3 的硬件

重要提示：不要让 Windows 操作系统选择 USB 驱动程序。按照第 2.2.2 节 “USB 驱
动程序安装”中指定的步骤操作。

MPLAB PM3 硬件的安装很简单：

• 如果使用 MPLAB IDE：
- 连接通信电缆。

- 将电源连接到 MPLAB PM3。
- 安装插座模块 （或连接 ICSP 电缆）。

• 如果以独立模式使用 MPLAB PM3：
- 将电源连接到 MPLAB PM3。
- 安装插座模块或连接 ICSP 电缆。

• 如果在 MPLAB PM3 中使用 MPLAB PM3 卡：

- 将 MPLAB PM3 卡插入编程器背面的 SD-MMC 端口。

2.3.1 安装通信电缆

MPLAB PM3 通过 RS-232 9 引脚的 D 型连接器或 USB 连接器与主机 PC 进行通信。
请参见图 2-1 以了解通信端口位置。

MPLAB PM3 附有两根 6 英尺数据线：一个带有 DB-9 连接器，另一个带有 USB 连接
器。串行电缆中的所有线都是直通的。串行电缆不是 null modem 电缆。

图 2-1： MPLAB® PM3 的后视图

注意

不要让 Windows 操作系统选择 USB 驱动程序。使用这个驱动程序 MPLAB PM3 无法运

行。必须按照 MPLAB IDE 软件安装中指定的步骤安装 USB 驱动程序或修复不正确的驱动

程序安装。

I O

打开
关闭电源

电源输入 USB 端口

USB
RS-232

  串口

PWR SD-MMC

安全数字 /
多媒体卡端口

电源
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2.3.1.1 对于 USB 通信

• 将 USB 电缆一端连接到 PC 上的 USB 端口。

• 从 PC USB 端口将电缆连接到 MPLAB PM3 背面对应的 USB 连接器。

2.3.1.2 对于 RS-232 通信

• 将RS-232电缆一端连接到PC上可用的COM端口。检查PC设置，看哪个通信端口
可用。

• 从 PC COM 端口将电缆连接到 MPLAB PM3 背面对应的 RS-232 连接器。关于串行
连接的更多详细信息，请参见第 A.2 节 “通过串口连接 PC”。

2.3.2 安装电源

MPLAB PM3 附有专用的外部电源。

1. 确保设备背面的电源开关处于 OFF 位置（见图 2-1）。

2. 将电源插入电源插座中，将电源电缆连接到设备。

注： 如果使用 USB 并且 PC 上显示 “检测到新硬件”，则必须按照指示正确安
装驱动程序，否则 MPLAB PM3 将无法运行。

注意

重要提示：将 COM 端口 FIFO 缓冲器设置为关闭，“流量控制”设置为 “硬件”，“波特

率”设置为 57600。您需要重启 PC 使这些设置生效。更多信息，请参见第 B.5.2.5 节

“手动设置端口”。
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2.3.3 安装插座模块或 ICSP 电缆

插座模块单独出售。 MPLAB PM3 附有 18 英寸 ICSP 电缆，用于 ICSP 编程。请参见
图 2-2 以了解插座模块连接器和 ICSP 连接器的位置。

图 2-2： MPLAB® PM3 的顶视图

2.3.3.1 插座模块安装

针对不同器件封装类型提供了不同的插座模块。“Product Selector Guide”
（DS00148）列出了 Microchip 的器件、工具和插座模块。《Microchip 开发系统订购
指南》（DS30177T_CN）介绍了所提供的插座模块。同时， Readme for MPLAB 
PM3文件列出了对每种器件的插座模块支持。

2.3.3.1.1 对于 MPLAB PM3 插座模块

1. 将插座模块上的连接器和 MPLAB PM3 上的连接器对齐 （图 2-2）。

2. 将插座模块均匀向下推，和连接器紧密配合。

每当更换插座模块时总是插入已知的空白器件进行空白检查，是一种好习惯。

2.3.3.1.2 对于 PRO MATE II 插座模块

ESC ENTER

状态

电源

MPLAB®   PM3
    器件编程器

ICSP 连接器

插座模块连接器

LED

LCD

键 / 按钮

M

注： MPLAB PM3 允许插座模块热插拔。如果状态 LED 没亮，可更换插座。

注 1： 要对 MPLAB PM3 使用 PRO MATE II 插座模块，必须取得 AC164350 适
配器工具套件。请参见 《Microchip 开发系统订购指南》
（DS30177T_CN）。

2： MPLAB PM3 不支持 PRO MATE II ICSP 插座模块。MPLAB PM3 附有一
根 18 英寸 ICSP 电缆，因此不需要使用 ICSP 插座。



安装 MPLAB PM3

 2006 Microchip Technology Inc. DS51464C_CN 第 15 页

1. 将适配器上的连接器和 MPLAB PM3 上的连接器对齐。

2. 将适配器均匀向下推，和连接器紧密配合。

3. 将插座模块和 MPLAB PM3 上的适配器对齐。

4. 将两个插座模块指旋螺丝均匀地同时拧紧。避免拧得过紧；用手指拧紧就够了。

每当更换插座模块时总是插入已知的空白器件进行空白检查，是一种好习惯。

2.3.3.2 ICSP 电缆安装

1. 将 ICSP 电缆连接器连接到 MPLAB PM3 上的 ICSP 插座 （图 2-2）。
2. 此时让各引线保持未连接状态。

2.3.3.3 插入 MPLAB PM3 卡

1. 将 MPLAB PM3 卡和 MPLAB PM3 编程器背面的 SD-MMC 插槽对齐，
将卡凹口端插入插槽。卡被锁住，只能沿一个方向插入。

2. 将卡推入插槽。

3. 要拔出卡，往里推释放。

2.4 对 MPLAB PM3 上电

连接硬件并安装了软件后，就可以开启 MPLAB PM3 了。将 MPLAB PM3 侧面的电源
开关转到 l （ON）（请见前面的图 2-1）。

如果自检的任何部分未通过， MPLAB PM3 将在 LCD 面板上显示纠正措施。对于正常
的启动， MPLAB PM3 将鸣叫一次。请参见第 B.7 节 “错误消息——LCD”以了解蜂
鸣代码和 LCD 错误消息。 MPLAB IDE 将提供进一步的信息帮助您解决问题。

成功上电时，应看到 MPLAB PM3 正面 LCD 面板上显示以下类型的消息：

• MPLAB PM3 闪屏

• 版本号和版权日期

• MPLAB PM3 菜单

此时就可以使用 MPLAB PM3 了。如果要通过 MPLAB IDE（Windows）使用 MPLAB 
PM3，请参见第 4 章 “通过 MPLAB IDE 使用 MPLAB PM3”。如果要以独立模式使
用 MPLAB PM3，请参见第 5 章 “以独立模式使用 MPLAB PM3”。如果要通过
MPLAB IDE 使用 MPLAB PM3 卡，或在独立模式下使用 MPLAB PM3 卡，请参见第 6
章 “使用 MPLAB PM3 卡”。

注： PRO MATE II 插座模块上的金色连接器条容易损坏。避免它们和插座模块
螺丝接触，避免将螺丝拧得过紧。

注： MPLAB PM3 自动执行自检，确保编程器正常工作。无需校准。
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2.4.1 指示灯和蜂鸣器

两个指示灯 （LED）都位于编程器正面。编程器内还有一个用于声音指示的蜂鸣器。

表 2-1： 状态 LED 指示

表 2-2： 电源 LED

2.4.2 关闭 MPLAB PM3 电源

将 MPLAB PM3 背面的电源开关转到 “OFF”。

2.5 为使用 MPLAB PM3 配置 MPLAB IDE

2.5.1 启动 MPLAB IDE
在 PC 上安装 MPLAB IDE 后，从 “开始”菜单选择 Programs （程序） >Microchip 
MPLAB IDE>MPLAB IDE。
MPLAB IDE 桌面应如图 2-3 所示。

图 2-3： MPLAB® IDE 桌面

LED 状态

红色 正在启动、编程失败以及其他错误

橙色 工作中 / 忙
绿色 编程通过

LED 状态

打开 编程器已上电

关闭 编程器未上电
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2.5.2 选择 MPLAB PM3 作为编程器

除了 MPLAB PM3 外，MPLAB IDE 下还支持 PRO MATE II 和 PICSTART Plus 器件编
程器。但是一次只能使用一个编程器。

选择 Programmer（编程器）>Select Programmer（选择编程器）>MPLAB PM3，从
可用编程器列表中选择 MPLAB PM3 （图 2-4）。选择 MPLAB PM3 之后：

• Programmer 菜单将包括有关 MPLAB PM3 编程器的菜单和 Settings （设置）。

• 显示 MPLAB PM3 工具栏。

• 编程器的名称显示在状态栏中。

图 2-4： 选择 PROGRAMMER 菜单
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2.5.3 设置通信端口

可设置 MPLAB PM3 通过串行 COM 端口 （1-4）之一或 USB 端口与 MPLAB IDE 通
信。

2.5.3.1 串行通信

从 MPLAB Programmer 菜单，选择 Programmer>Settings 并单击 Communications
（通信）选项卡。将显示一个对话框，该对话框和图 2-5 中相似。

图 2-5： 通信端口设置对话框

通信端口设置对话框显示可能的 PC 串口和 USB 通信端口。单击 OK 设置选项，或单
击 Cancel 忽略更改并关闭对话框。
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2.5.3.2 USB 通信

要在 PC 和 MPLAB PM3 器件编程器之间使用 USB 通信，请选择 USB 端口 （图
2-6）。单击 OK。

图 2-6： USB 端口

要确保端口设置正确，按照第 2.3.1 节 “安装通信电缆”中 “对于 USB 通信”部分的
指示操作。

警告

不要让 Windows 操作系统选择 USB 驱动程序，这不仅不可行，而且随后您将无法安装正

确的驱动程序。按照第 2.2 节 “安装 MPLAB PM3 的软件”中指定的步骤操作。
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2.5.4 在 MPLAB IDE 中选择器件

选择 Configure （配置） >Select Device （选择器件），从可用器件列表选择要编程的
器件 （图 2-7）。选择器件时， Microchip 工具名称旁的指示符显示了对该器件的支持
级别。

• 绿色——支持器件

• 黄色——有限 （超前）支持

• 红色——不支持

如果 MPLAB PM3 支持所选器件，请单击 OK。

图 2-7： SELECT DEVICE 对话框

2.5.5 使能 MPLAB PM3
要使能 MPLAB PM3，请选择 Programmer>Enable Programmer （使能编程器）
（图 2-8）。 MPLAB PM3 工具栏将在使能编程器后显示。请参见第 7 章 “MPLAB 
PM3—MPLAB IDE 参考信息”以了解更多有关 MPLAB PM3 编程器的参考信息。只
有当 MPLAB PM3 编程器中插有 MPLAB PM3 卡时，才可通过 Programmer 菜单对
MPLAB PM3 卡进行操作。

MPLAB IDE 会警告您编程器操作系统工具包已过期。如果选择自动更新编程器操作系
统， MPLAB IDE 将在收到警告时，自动更新必要的文件。

图 2-8： 使能编程器
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如果在所选端口上未找到 MPLAB PM3，将显示通信错误对话框 （图 2-9）。

图 2-9： 通信错误对话框

如果无法在 PC 和 MPLAB PM3 之间建立通信，请确保正确安装了硬件和软件。如果
您仍无法在 PC 和 MPLAB PM3 之间建立通信，请参考附录 B “疑难解答”。

如果使用了其他编程器 （如 PICSTART Plus）， MPLAB PM3 菜单可能不可用。从
Programmer 菜单中，选择 Programmer>Select Programmer （选择编程器），并从编
程器列表中选择 MPLAB PM3。关于 MPLAB PM3 的菜单将显示在菜单栏上。

2.5.6 将器件插入 MPLAB PM3 中

如果使用插座模块，将要编程的器件插入 MPLAB PM3 插座中。将引脚 1 和插座顶部
对齐。向下推插座上的银色杆或合上盖子，固定器件。
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注：
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第 3 章  教程

3.1 简介

本章中的教程将一步步指导您使用 MPLAB IDE 项目向导对 PIC18F452 PICmicro 器件
进行编程。

3.2 开始之前

开始本教程之前，您必须：

1. 安装 MPLAB IDE 软件。请参见第 2.2 节 “安装 MPLAB PM3 的软件”。

2. 安装 MPLAB PM3 硬件。请参见第 2.3 节 “安装 MPLAB PM3 的硬件”。

3. 确保您已阅读并完成了第 2.4 节 “对 MPLAB PM3 上电”和第 2.5 节 “为使用
MPLAB PM3 配置 MPLAB IDE”中的所有指示步骤。

4. 开始本教程前，确保您的 PC 和 MPLAB PM3 正在通信，并且 MPLAB IDE 菜单
中出现关于 MPLAB PM3 的菜单。

3.3 编程概述

对器件编程包括以下步骤：

• 选择器件

• 创建项目

• 设置语言工具

• 命名项目

• 向项目中添加文件

• 编译初始项目

• 创建代码

• 编译项目

• 使能 MPLAB PM3
• 对器件编程

• 校验编程
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3.4 选择器件

如果尚未在 MPLAB IDE 中选择器件，请通过选择 Configure>Select Device 打开
Select Device 对话框 （图 3-1）并选择 PIC18F452 器件。

在 Microchip Programmer Tool Support （Microchip 编程器工具支持）下，确认
MPLAB PM3 是支持该器件的 （绿色灯）。单击 OK。

图 3-1： 选择器件

3.5 创建项目

要对器件编程，您需要一个十六进制文件。在本示例中，我们将用项目向导创建一个
项目。在该项目中我们将使用一个汇编文件和一个链接描述文件。选择 Project （项
目） >Project Wizard （项目向导）。

图 3-2： PROJECT WIZARD 欢迎屏幕

单击 Next> 进入 Project Wizard 的下一个对话框。
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下一个对话框让您选择器件，这我们已经完成了。确保对话框中显示的是
PIC18F452。如果不是，从下拉菜单中选择 PIC18F452。单击 Next>。

图 3-3： 项目向导——选择器件
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3.6 设置语言工具

项目向导的第二步设置该项目使用的语言工具。在 Active Toolsuite （有效工具包）列
表框中选择 Microchip MPASM Toolsuite （Microchip MPASM 工具包）。随后就应该
可以在 Toolsuite Contents （工具包内容）框中看到 MPASM 和 MPLINK。单击每个工
具包查看其路径。如果 MPLAB IDE 安装到了默认目录中，则 MPASM 汇编器的可执
行文件及其路径为：

C:\Program Files\Microchip\MPASM Suite\MPAsmWin.exe

MPLINK 链接器的可执行文件及其路径为：

C:\Program Files\Microchip\MPASM Suite\MPLink.exe

如果显示不正确，用 Browse （浏览）按钮将它们设置为 MPLAB IDE 子文件夹中的
正确文件。

图 3-4： 项目向导——选择语言工具

完成后，单击 Next>。
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3.7 命名项目

该向导的第三步让您命名项目，并将它放入文件夹中。本示例项目将命名为
18F452Proj。使用Browse按钮，将该项目放入C驱动器上名为My Projects的文件
夹中。单击 Next>。

图 3-5： 项目向导——命名项目
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3.8 向项目中添加文件

项目向导的第四步是为项目选择文件。因为还没有选择源文件，所以我们将使用
MPLAB IDE 模板文件。模板文件是可用于开始项目的简单文件。它们含有任何源文件
的基本部分，并包含可帮助您编写和组织代码的信息。这些文件与 MPLAB IDE 在同一
个文件夹中，该文件夹默认位于 PC 的 Program Files文件夹中。每个 Microchip 
PICmicro MCU 和 dsPIC® DSC 器件都有一个模板文件。

滚动到驱动器 C: 上的 Program Files文件夹，打开它，向下滚动到 Microchip文
件夹。打开 Microchip文件夹并向下滚动到 MPASM Suite目录。打开 MPASM 
Suite目录，从 Template文件夹中的 Object文件夹中取得模板，选择名为
f452tmpo.asm的文件。

如果 MPLAB IDE 安装到默认路径，该文件的完整路径将是：

C:\Program Files\Microchip\MPASM Suite\TEMPLATE\Object\f452tmpo.asm

图 3-6： 项目向导——选择模板文件

按 Add （添加） >> 将文件名移动到右边面板，单击带有该文件名的行首的复选框，
使该文件复制到项目目录中。
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接下来为项目添加第二个文件，链接描述文件。每个器件都有一个链接描述文件。这
些文件定义不同器件的存储器配置和寄存器名称。链接描述文件位于 MPASM Suite
文件夹下名为 LKR的文件夹中。使用名为 18F452.lkr的文件。完整路径是：

C:\Program Files\Microchip\MPASM Suite\LKR\18F452.lkr

要将该链接描述文件复制到项目中，请单击该复选框。

图 3-7： 项目向导——选择链接描述文件

确保对话框如上图所示 （两个复选框都选中），然后按 Next> 结束项目向导。

最后一个项目向导屏幕是显示所选器件、工具包和新项目文件名的汇总。

图 3-8： 项目向导——汇总



MPLAB® PM3 用户指南

DS51464C_CN 第 30 页  2006 Microchip Technology Inc.

按 Finish 按钮后，查看 MPLAB IDE 桌面上的项目窗口。它看上去应像图 3-9。如果项
目窗口未打开，选择 View （查看） >Project。

图 3-9： 项目窗口

3.9 编译初始项目

可以通过 Project 菜单汇编并链接当前的文件。它们还不包含任何代码，但这可确保项
目设置正确。

点击 18f452Proj.mcw 窗口，使之成为活动窗口。现在，通过选择 Project>Build All
（编译所有）来编译项目。 Output （输出）窗口显示编译过程的结果，如图 3-10 中所
示。

图 3-10： 初始编译结果窗口
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3.10 创建代码

通过双击 Project 窗口中模板文件的名称打开项目中的模板文件 （见图 3-11）。
文件开头有一些注释，该区域可用作文件的标准注释信息头。现在无需修改它，但如
果是实际项目，这里就要填写设计信息。

图 3-11： 模板文件

向下滚动到文件底部。

文件第一部分中的代码是用于高级功能的，例如在最终应用程序中设置中断位和配置
位。我们现在将主要精力放在编写代码上，这些细节可以忽略。新代码将放入文件中
的符号 Main定义之后。

图 3-12： 模板文件——MAIN
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打开任何源文件都会自动打开编辑器。输入以下代码：

Main:

clr f WREG
movwf PORTC; clear PORTC
movwf TRISC; configure PORTC as all outputs

Init
clrf COUNT

IncCount
incf COUNT
movf COUNT,W
movwf PORTC; display COUNT on PORTC

callDelay
goto IncCount; infinite loop

Delay
movlw 0x40; set outer delay loop
movwf DVAR2

Delay0
movlw 0xFF
movwf DVAR; set inner delay loop

Delay1
decfsz DVAR
goto Delay1

decfsz DVAR2
goto Delay0
return

模板文件现在看上去应像图 3-13。

图 3-13： 模板文件——添加代码
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在这小段代码中，我们使用了三个变量，分别是 COUNT、 DVAR和 DVAR2。在模板文
件中需要将这三个变量定义到未初始化数据的 UDATA段中。在模板文件中，这个段中
已有三个变量了，我们的变量可用同样格式添加到末尾。每个变量都是 8 位，因此只
需为每个变量保留 1 个字节。

图 3-14： 模板文件——添加变量

添加
这三行
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3.11 编译项目

选择 Project>Build All 以汇编并链接代码。如果代码汇编无错误， Output 窗口看上去
将像图 3-15。

图 3-15： 编译 OUTPUT 窗口

选择 File>Save Workspace （保存工作区）以保存项目。

如果没有成功汇编和链接，检查以下各项然后重新编译项目：

• 检查编辑器窗口中输入代码的拼写和格式。确保新的变量和特殊功能寄存器 TRISC
和 PORTC 都是大写的。如果汇编器在 Output 窗口中报告错误，双击该错误，
MPLAB IDE 将打开源代码中的相应行，并在源代码窗口左边缘显示绿色箭头。

• 检查是否使用了正确的 PICmicro MCU 器件汇编器 （MPASM 汇编器）和链接器。
选择 Project>Set Language Tool Locations （设置语言工具路径）。单击加号框展
开 Microchip MPASM Toolsuite 及其 Executables 路径。单击 MPASM Assembler 
(mpasmwin.exe) 并复查显示的路径。如果路径正确，单击 Cancel。如果不正
确，更改它然后单击 OK。默认搜索路径可能是空的。

成功编译后，将装载语言工具生成的输出文件。该文件包含可烧写到 PICmicro MCU
中的目标代码以及调试信息，从而可以调试源代码并在 Watch （观察）窗口中以符号
形式查看源变量。

现在您已经成功编译了项目，就可以准备对器件编程了。
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3.12 使能 MPLAB PM3
如果尚未启动 MPLAB PM3 器件编程器，选择 Programmer>Enable Programme （使
能编程器）。 MPLAB PM3 工具栏将在使能编程器后显示。

选择 View>Program Memory （程序存储器）并单击窗口底部的 Opcode Hex （十六
进制操作码）（见图 3-16）来查看您刚编译的十六进制代码。您可在显示器上缩放或
移动 Program Memory 窗口。您可能希望关闭 Build Results （编译结果）窗口。

图 3-16： 查看程序存储器
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3.13 对器件编程

现在程序存储器中已有数据了，就可以对器件编程了。确保将 PIC18F452 器件插入
MPLAB PM3 上的相应插座中。然后，选择 Programmer>Program（程序）。MPLAB 
IDE 窗口将指示进度，完成时， Output 窗口将显示结果 （见图 3-17）。

图 3-17： 编程结果

3.14 校验编程

选择 Programmer>Verify （校验）再次检查器件的编程。如果器件上的地址单元与程
序存储器中的不匹配，错误日志将显示这些差异。如果错误日志中的错误数据是
0000，试着重新安装插座模块。

3.15 教程总结

通过完成该教程，您完成了创建、编译和对简单项目编程的主要步骤。完成的任务包
括：

选择器件——PIC18F452。
用项目向导创建项目并使用向导：

• 选择 MPLAB IDE 中内置的 MPASM 汇编器和 MPLINK 连接器语言工具。

• 为项目添加文件：添加所选器件的模板文件及其链接描述文件以正确地编译项目。

编写一段简单代码，将变化的值发送到 I/O 端口。

编译项目。

最后，对 PIC18F452 器件编程。

这就是用 MPLAB IDE 和 MPLAB PM3 对器件编程的主要步骤。



 2006 Microchip Technology Inc. DS51464C_CN 第 37 页

MPLAB® PM3
用户指南

第 4 章  通过 MPLAB IDE 使用 MPLAB PM3

4.1 简介

本章说明了用 MPLAB PM3 器件编程器对器件进行编程和读取的主要步骤。本章讨论
的主题包括：

• 开始之前

• MPLAB PM3 对话框

• 器件编程的设置

• 对器件编程

• 校验编程

• 读取器件

• 特殊编程

4.2 开始之前

使用 MPLAB PM3 之前，必须已执行以下初始步骤：

1. 安装了 MPLAB IDE 软件（第 2.2 节“安装 MPLAB PM3 的软件”）和 MPLAB 
PM3 硬件 （第 2.3 节 “安装 MPLAB PM3 的硬件”）。

2. 打开 MPLAB PM3 电源 （第 2.4 节 “对 MPLAB PM3 上电”）。

3. 已选择 MPLAB PM3 作为编程器 （第 2.5.2 节 “选择 MPLAB PM3 作为编程
器”）。

4. 配置了 MPLAB IDE 用于和 MPLAB PM3 通信的通信端口 （第 2.5.3 节 “设
置通信端口”）。

5. 从可用器件列表中选择了要编程的器件 （第 2.5.4 节 “在 MPLAB IDE 中选择
器件”）。

6. 使能 （启动）了 MPLAB PM3 编程器 （第 2.5.5 节 “使能 MPLAB PM3”）。

4.3 MPLAB PM3 对话框

MPLAB PM3 编程器菜单选项在使能编程器后显示。如果选项不可用，该项将显示为
灰色 （而不是黑色）文本。

下一节将讨论如何使用这些对话框对器件编程。

4.4 器件编程的设置

要对器件编程，需要：

• 要烧写到器件中的十六进制文件。

• 要编程的器件。如果不是闪存器件，必须为空白。（请参见第 7.4.7 节 “Blank 
Check All”。）
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4.5 对器件编程

对器件编程的步骤包括：

• 在 Configuration Bits （配置位）对话框中设置配置位。

• 如果需要，在 User ID Memory （用户 ID 存储区）对话框中编辑 ID。

• 将十六进制代码装载到程序存储器，或将项目编译到程序存储器中。

• 检查是否为空白器件 （非闪存器件）

• 对器件编程

• 校验编程

• 读取器件

4.5.1 Configuration Bits 对话框

Configuration Bits 对话框在选择 Configure>Configuration Bits 时打开。在此对话框中
看到的配置位类型和数量取决于选择的器件。

也可以在源代码中指定配置位的值。使用 MPASM 汇编器中的 __CONFIG伪指令设置
要编程器件的配置位。每次重新编译项目或重新装载十六进制文件时，配置位都将根
据该伪指令设置的值设置配置位。

如果不在源代码中设置配置位，这些位就不会被更改。可以用 Configuration Bits 对话
框手动将它们从默认值更改为其他值，会在对单片机编程时将配置位的值烧写到器件
中。

Configuration Bits 对话框中设置的值将覆盖程序中设置的任何值。

要更改配置位设置：

1. 确保 Configuration Bits 窗口打开得足够宽，能够看到 Settings （设置）栏
（图 4-1）。

图 4-1： CONFIGURATION BITS 对话框

2. 单击要更改的设置值。该值右边出现一个向下箭头。从下拉列表框中选择一个
值。

注： 在这里设置配置位不会影响仿真器或软件模拟器的运行。
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4.5.2 User ID Memory 对话框

选择 Configure>ID Memory 编辑用户 ID 存储地址。

还可以使用 __IDLOCS伪指令通过 MPASM 汇编器设置 ID 字节。每次重新编译项目
或重新装载十六进制文件时，都将根据 __IDLOCS伪指令设置的值设置 ID 存储单元。

User ID Memory 对话框 （图 4-2）中设置的 ID 值将覆盖程序中设置的任何值。

图 4-2： USER ID MEMORY 对话框

要更改用户 ID：

1. 在该域中输入用户 ID。

2. 按需要选中或清除 Use Unprotected Checksum （使用未代码保护的校验和）复
选框。

如果器件被代码保护了，建议选中该复选框，以便使用未代码保护的校验和。多
数器件使用该信息来计算代码保护的校验和。

3. 单击 OK 设置该选项，或单击 Cancel 取消设置。
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4.5.3 将十六进制代码装载到程序存储器中

如果您有准备好要烧写到单片机中的十六进制文件 （例如 code.hex），请打开
Program Memory 窗口 （如果还未打开）。为此，从 MPLAB IDE 菜单，选择
View>Program Memory。然后，选择 File>Import... （导入）以浏览找到要装载到
MPLAB IDE Program Memory 窗口中的文件。

Program Memory 窗口现在应包含来自十六进制文件 （图 4-3）的十六进制代码。

图 4-3： PROGRAM MEMORY——十六进制代码显示

如果没有用于对器件编程的十六进制文件，可以用 MPLAB IDE 项目生成一个十六进制
文件。 MPLAB IDE 提供了一个文本编辑器，用于生成源代码，并与将源代码汇编 / 编
译为 MPLAB IDE 程序存储器中十六进制代码的各种汇编器 / 编译器兼容。使用
MPLAB IDE 项目创建用于对器件编程的十六进制文件的示例，请参见第 3 章 “教
程”。请阅读 MPLAB IDE 文档，查看如何用 MPLAB IDE 项目开发自己的固件。

每次重新编译项目时，都将更新 Program Memory 窗口。

4.5.3.1 导入的十六进制文件和 EEPROM 数据

如果将十六进制文件导入到了 MPLAB IDE 中，并使用 EEPROM 数据存储器，请确保
十六进制代码指定了 EEPROM 数据存储器的起始地址。需要为编程器指定这个起始
地址。

注： 导入带有无效十六进制值的文件时，不会有警告。也就是说， 14 位器件的
十六进制文件可能会装载到 12 位器件的程序存储器中，而 16 位器件的十
六进制文件可能装载到 14 位器件的程序存储器中。
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4.5.4 检查是否为空白器件 （非闪存器件）

可通过从 MPLAB PM3 菜单选择 Programmer>Blank Check All 执行空白检查。该检查
将校验器件是否完全空白 （所有位都设置为 1）并且所有配置位都设置为 1（未编程
状态）。

如果使用 “一次编程”（OTP）器件，某些配置位 （例如振荡器位）可能已在出厂时
编程了。确保配置位是出厂设置，并选择 Programmer>Blank Check OTP （空白检查
OTP）。这将检查所有程序存储器位是否都设置为 1，并且配置位与对话框中的值是否
匹配。 OTP 器件不能擦除和再编程。

如果 EPROM 器件不是空白的，就必须擦除它才能对其编程，或要选择其他器件。

1. 除去覆盖在器件窗口上的任何标签。如果不是窗口器件 （图 4-4），就不能对它
再编程。所有 EPROM 器件的窗口版本可通过请求 JW 封装订购。

图 4-4： 窗口器件

2. 将器件放入紫外线 （UV） EPROM 擦除器中。完全擦除紫外线可擦除器件所需
的时间取决于：紫外线的波长、强度、到紫外线源的距离以及器件的工艺技术
（存储单元的尺寸）。

3. 尝试对器件编程前，请检查器件是否为空白的 （即再次执行空白检查）。

如果器件是 EEPROM/ 闪存，无需在再编程前擦除它。这些器件会在编程前进行电擦
除。
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4.5.5 对器件编程

您已做好了对器件编程的准备。选择 Programmer>Program 对整个器件 （即所有程序
存储器和配置位等）编程。

如果要有选择地编程 （例如，程序存储器的一部分或仅配置位），请选择
Programmer>Settings 以打开 Programmer 对话框。单击 Memory Ranges （存储器
范围）选项卡 （请参见表 4-1 和第 7.5.1 节 “Memory Ranges 选项卡”），并选择编
程的选项。灰掉的区域在该器件上不可用。单击 OK。然后选择
Programmer>Program 对器件编程。将对对应于所选复选框的存储器区域进行编程。

MPLAB PM3 对器件编程后，自动执行校验操作，并显示发现的任何错误。另一种校
验操作可通过选择 Programmer>Verify 执行。

4.6 校验编程

单击 Programmer>Verify 以校验对器件的编程与 MPLAB IDE、 Programmer 对话框及
Configuration Bits 对话框中的程序存储器、配置位、 ID 存储单元、 EEPROM 以及校
准存储器值是否匹配。

如果错误个数超出预期，并且这些错误称错误数据是全零 （0000），插座模块可能没
有正确安装到位。拔出并重新安装插座模块。每当更换插座模块时总是插入已知的空
白器件并进行空白检查，是一种好习惯。

表 4-1： MEMORY RANGES 选项卡选项

选项 说明

Program Memory Start Address （程序
存储器起始地址）

输入程序存储器范围的起始地址。

Program Memory End Address （程序
存储器结束地址）

输入程序存储器范围的结束地址。

Reset Addresses （复位地址） 单击该按钮将程序存储器地址复位。

Program Memory （程序存储器） 如果要对程序存储器编程，请选中此复选框。程序
存储器范围由程序存储器起始和结束地址字段确定。

Configuration Bits 如果要对配置存储器编程，请选中此复选框。

ID Location （ID 存储单元） 如果要对 ID 存储单元编程，请选中此复选框。

EEPROM Data （EEPROM 数据） 如果要对 EEPROM 数据存储器编程，请选中此复
选框。

Calibration Memory （校准存储器） 如果要对校准存储器编程，请选中此复选框。

Erase All Before Program （编程前全部
擦除）

如果要在编程前擦除器件，请选中此复选框。

注： 编程命令后会自动进行校验。
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4.7 读取器件

要从已编程的器件将固件复制到未编程器件中，请将已编程固件 （程序存储器和配置
位等）读取到 MPLAB IDE 中，然后根据这些信息对新器件编程。

要读取整个器件 （即所有程序存储器和配置位等），单击 Programmer>Read。
要有选择地读取 （例如，程序存储器的一部分或仅配置位），请选
择 Programmer>Settings>Memory Ranges 以显示 Memory Ranges 对话框。选择要读
取的选项，然后单击此对话框中的 OK。灰掉的区域在该器件上不可用。然后，选择
Programmer>Read （读取）。对应于所选复选框的存储器区域将被读取。

读取完成后， Program Memory 窗口将显示从主器件读取的数据。您可以将这些数据
保存为十六进制文件 （File>Export （导出）），将新器件插入 MPLAB PM3 中，从而
将相同数据复制到新器件中，或在保存到十六进制文件或对其他器件编程前在 MPLAB 
IDE 中修改数据。

如果尝试读取代码保护的器件，将收到一条警告，指明该器件是代码保护的，读取程
序存储器可能无效。如果出现这种情况，请从文件或非代码保护器件获取原始十六进
制代码。

如果 MPLAB IDE 连接有 MPLAB ICE 仿真器，您的代码将下载到 MPLAB ICE 的仿真
程序存储器。如果有打开的项目，将问您是否要在从器件读存储器之前关闭它。

将器件读取到 MPLAB IDE 后，其数据将显示在 Program Memory 窗口中。您可修改
数据，然后通过选择 Project>Build Options （编译选项） >Project 保存到十六进制文
件。有关更多信息，请参见 MPLAB IDE 文档。

4.8 特殊编程

4.8.1 SQTP

带序列号的快速批量编程 （SQTP）允许您将唯一的序列号烧写到每个器件中。该编
号可用作记录码、密码或 ID 号。

序列号是通过一系列 RETLW（从子程序返回，并将立即数存储到 W 中）指令实现的，
序列号字节作为立即数。要生成序列号，首先必须生成序列号文件，然后用该文件将
序列号烧写到单片机中：

1. 要生成 SQTP 文件，请选择 Programmer>Settings，单击 SQTP 选项卡，并填写
对话框。

2. 要激活序列号，请选择 Programmer>Load SQTP File （装载 SQTP 文件）并选
择该文件。

3. 要对该器件编程，请选择 Programmer>Program。

有关 SQTP 编程的更多详细信息，请参见第 7.5.3 节 “SQTP 选项卡”和第 7.6.1 节
“使用 SQTP”。请参见第 7.7.1 节 “使用十六进制记录格式”以获取有关十六进制记
录格式的信息。

注： 如果保持项目打开，绝对列表窗口和源代码窗口可能与读入 Program 
Memory 窗口的数据不匹配。符号可能与 Program Memory 窗口中的正确
地址不匹配。
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4.8.2 ICSP 编程

ICSP （在线串行编程）插座是 MPLAB PM3 器件编程器的扩展，允许您对已安装在目
标电路板上的 PICmicro 单片机编程。

MPLAB PM3 配有 ICSP 插头和电缆。您可以在安装插座模块的位置下找到该连接器。
请参见第 A.4 节 “ICSP 硬件规范”以获取插头和电缆引脚排列的信息。

要用 ICSP 对器件编程：

1. 选择 Programmer>Settings 并单击 Voltages （电压）选项卡。

2. 在 ICSP Options （ICSP 选项）区域，选择 Low Voltage Program （低电压编
程）以使用该方法编程。如果选择了 Low Voltage Program 选项，请确保连接
LVP/PGM 引脚并使能 Low Voltage Program 配置位。如果要通过 MPLAB PM3
而不是用目标板的电源对电路供电，请选择 Power target circuit from MPLAB 
PM3 （通过 MPLAB PM3 对目标电路供电）（图 4-5）。

图 4-5： ICSP™ 选项

3. 将 ICSP 电缆连接器连接到 MPLAB PM3 上的 ICSP 插座。

4. 将所需电缆连接到目标板上的插头。请参见附录 A “硬件规范”中的表 A-3
以获取电缆引脚、颜色和信号的信息。

5. 对器件编程。请参见第 4.5 节 “对器件编程”。

注： 有关如何用 ICSP 对特定器件编程的信息，请查阅该器件的编程规范。请
参见 MPLAB PM3 的自述文件以获取所支持器件的编程规范列表。编程规
范也可在 Microchip 网站 www.microchip.com 上找到。
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第 5 章  以独立模式使用 MPLAB PM3

5.1 简介

本章简要说明如何以独立模式使用 MPLAB PM3 器件编程器。该器件编程器提供一个
能够全面控制编程会话的图形 LCD 接口。本章讨论的主题包括：

• 独立模式入门

• 对器件编程

请参见第 8 章 “独立模式参考信息”以了解如何以独立模式使用 MPLAB PM3 的详细
说明。

5.2 独立模式入门

运行于独立模式的 MPLAB PM3 使您能在不使用 PC 的情况下对器件进行读取、编程
和校验。独立模式在没有甚至不需要 PC 的场合很有用，例如野外现场或实验室生
产环境。

5.2.1 安装插座模块

有关说明请参见第 2.3.3 节 “安装插座模块或 ICSP 电缆”。

请确保为要编程的器件安装了适合的插座。当 MPLAB PM3 器件编程器上电时，将自
动检测安装的插座模块类型。如果器件不支持安装的插座， MPLAB PM3 将列出应使
用的适合插座。

5.2.2 将十六进制文件下载到 MPLAB PM3 存储器

要将 MPLAB PM3 设置为以独立模式工作，您需要 PC 来下载十六进制文件，或主器
件来读入 MPLAB PM3 存储器。请分别参见第 2 章 “安装 MPLAB PM3”和第 4.5.3
节 “将十六进制代码装载到程序存储器中”以获取将 MPLAB PM3 连接到 PC 以及下
载十六进制文件的指示。

现在可以按独立模式使用 MPLAB PM3 了。

注： MPLAB PM3 附有一根 18 英寸 ICSP 电缆，因此不需使用 ICSP 插座。

注 1： MPLAB PM3 支持热插拔插座模块。当状态 LED 未点亮时，可更换插
座。

2： 要对 MPLAB PM3 使用 PRO MATE II 插座模块，必须取得 AC164350 适
配器工具套件。请参见 《Microchip 开发系统订购指南》
（DS30177T_CN）。
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5.3 对器件编程

对 MPLAB PM3 上电后，会短暂显示 MPLAB PM3 闪屏和版本信息。然后， MPLAB 
PM3 显示主菜单。

图 5-1： MPLAB® PM3 主菜单

• Recently Used （最近使用过的）

• Select Device （选择器件）

• MPLAB PM3 Card （MPLAB PM3 卡）（如果已插入）

• Programmer Settings （编程器设置）

• Help （帮助）

5.3.1 Recently Used

选择 Recently Used 以检索 MPLAB PM3 中最近使用的器件。该选项显示七个最近使
用过的器件，并使能对器件命令菜单的快速访问。

5.3.2 Select Device

选择 Select Device 以指定器件系列，然后选择要编程的器件。选择器件后， MPLAB 
PM3 将显示命令菜单，其中的命令适用于该器件类型及其功能，例如 Program/Verify 
Device （编程 / 校验器件）、 Verify Device （校验器件）和 All Functions （所有功
能）。

5.3.2.1 PROGRAM/VERIFY DEVICE

选择 Program Verify Device 用先前装载到器件编程器内部存储器的十六进制文件对插
座模块中的器件编程。这称为镜像。如果未装载十六进制文件，系统将显示一条消息，
告诉您 “Valid image not present!Please download an image or use a master device 
before continuing （不存在有效镜像！请下载镜像或使用主器件再继续）”。将要烧写
到器件中的十六进制文件下载到 MPLAB PM3 中，再尝试继续。

器件编程器检查已安装的单片机器件是否是空白的。如果该器件不是空白的，器件编
程器将询问是否要继续。回答 Yes 继续。回答 No 返回命令菜单。

如果使用的是闪存器件，将直接用 MPLAB PM3 中的镜像对器件编程。如果使用的是
一次编程 （OTP）器件，且 MPLAB PM3 上使能了 Blank Check Override （空白检查
覆盖），那么在器件不是空白时将显示两个选项：Stop Programming （停止编程）和
Continue （继续）。如果不想继续编程，请选择 Stop Programming。否则选择
Continue，器件将继续编程。

MPLAB PM3 将十六进制文件的镜像烧写到连接在编程器上的单片机器件中。

Programmer Settings

MPLAB® PM3
Recently Used
Select Device

Help

MPLAB PM3 Card
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将在所施加 VDD、 VDD 最小值和最大值 （OTP 器件），或根据器件工作电压范围确定
为默认值的 VDD 标称值下进行编程。如果需要在其他电压设置下执行校验，请参见第
8.5.3.7.3 节“Adjust Voltages”。将在编程后立即根据 MPLAB PM3 镜像对器件进行
校验，如果编程和校验都成功了，还将显示最终的校验和。

如果编程或校验中发生错误， LCD 上将报告未通过的每个存储区域的起始地址。

5.3.2.2 VERIFY DEVICE

选择 Verify Device 以比较器件内容和 MPLAB PM3 存储器 （镜像）的内容。将在所施
加 VDD、 VDD 最小值和最大值 （OTP 器件），或根据器件工作电压范围确定为默认值
的 VDD 标称值下进行此比较。如果需要在其他电压设置下执行校验，请参见第
8.5.3.7.3 节 “Adjust Voltages”。

如果器件内容和 MPLAB PM3 镜像相匹配， LCD 上将显示 “Passed!”（已通过！）
及最终的校验和。如果不匹配， LCD 上将报告未通过的每个存储区域的起始地址。

5.3.2.3 READ DEVICE （读取器件）

选择 All Functions，然后选择 Read Device 以获取器件内容并存放入 MPLAB PM3 存
储器。该镜像随后可用于以同样的信息对后续器件编程，或者可对这些信息进行代码
保护，然后用于编程。

如果器件被代码保护， LCD 上将显示一条说明器件被代码保护的消息，器件内容将不
会存放入 MPLAB PM3 存储器中。但是，最终校验和将包括在显示中 （如果
Programmer Settings 中使能了该选项）。

如果器件未被代码保护，器件内容将存放入 MPLAB PM3 存储器中。 LCD 上将显示两
个选项 （No （否）和 Code Protect All? （全部代码保护？））以及最终校验和。如
果不需要对当前或后续器件进行代码保护，请选择 No。否则，如果需要对当前或后续
器件进行代码保护，请选择 Code Protect All?。
选择代码保护选项后，将返回到 Read Device 选项。请按 <ESC> 键以返回到器件的
命令菜单。如果选择了代码保护，要使用 MPLAB PM3 存储器中的代码保护镜像对当
前或后续器件编程，就必须使用 Program Verify Device。

5.3.2.4 ALL FUNCTIONS

选择 All Functions 以显示适用于编程、读取、校验和显示当前选中器件状态的全部独
立命令。请参见第 8.5.3 节 “All Functions”以了解该器件可用的每个选项的详细信
息。
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5.3.3 MPLAB PM3 Card

如果将存储卡插入到了 MPLAB PM3 中，主菜单将包括 MPLAB PM3 Card 选项。选择
该选项后将另外显示以下选项。请参见第 9.4 节 “以独立模式使用 MPLAB PM3 卡”
以了解这些选项的详细信息：

• Load an Environment （载入环境）

• View an Environment （查看环境）

• View Disk Contents （查看磁盘内容）

• Open a text File (*.txt) （打开文本文件 （*.txt））
• Card Properties （卡属性）

5.3.4 Programmer Settings

从主菜单上的 Programmer Settings 选项，可访问以下选项。请参见第 8.4.3 节
“Programmer Settings”以了解更多详细信息。

• Screen Contrast （屏幕对比度）

• Buzzer Volume （蜂鸣器音量）

• Socket Information （插座信息）

• Checksum Calculation （校验和计算）

• Device ID Option (Beta) （器件 ID 选项 （测试版功能））

• Blank Check Override （空白检查覆盖）

• Go Pin Functionality （Go 引脚功能）

5.3.5 Help

Help 选项显示 MPLAB PM3 上运行的 MPLAB PM3 操作系统工具包的版本号和以下子
菜单选项。请参见第 8.4.4 节 “Help”以了解详细信息。

• ICSP Connector Pinout （ICSP 连接器引脚排列）

• Status Bar Icons （状态栏图标）

• About （关于）
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第 6 章  使用 MPLAB PM3 卡

6.1 简介

本章将说明 MPLAB PM3 卡的功能并介绍环境的概念。

MPLAB PM3 卡是邮票大小的多媒体闪存卡，重约 2 克。它提供：

• 存储和传输信息的便携途径

• 快速复制 / 下载

• 高存储容量

• 非易失性固态，数据在电源关闭时不会丢失

• 卡外壳上的写保护开关 （仅对于 SD 卡）

用 MPLAB PM3 卡可以将信息存储到 MMC 卡，发送给制造商，让他们将数据存放到
MPLAB PM3 中，甚至无需使用 PC 就能对 Microchip 的单片机编程。

本章讨论的主题包括：

• MPLAB PM3 环境

• MPLAB PM3 卡
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6.2 MPLAB PM3 环境

MPLAB PM3 器件编程器使用叫做 “MPLAB PM3 环境”的新概念。环境是特定器件
当前编程设置的快照。它包含重新创建当前编程状态的所有必需信息，包括器件存储
器数据的二进制镜像、到可选 SQTP 文件的链接、特定的部件信息和可选的其他文
件。

保存环境后，将在可移动的 MPLAB PM3 卡 （SD-MMC 存储卡）、 PC 上的选定驱动
器或其他存储器上创建目录。创建的目录名称和环境文件的名称相同。图 6-1 展示了
一个 “环境”的布局。

作为环境的简介，本章将讨论：

• 在 MPLAB PM3 卡上创建 MPLAB PM3 环境

• 将 MPLAB PM3 环境载入到 MPLAB PM3 编程器

以及其他操作，例如查看、复制和删除环境。请参见第 9 章 “MPLAB PM3 卡参考信
息”以查看这些操作的具体说明。

图 6-1： 环境的组成

环境由环境文件 （*.pm3）、二进制 bin 文件 （*.bin）、可选的 SQTP num 文件
（*.num）和其他文件组成。

PM3 文件 （*.pm3）是环境的一部分。它是包含 MPLAB PM3 设置、 bin 文件名称和
SQTP 文件名称的高级文件。

器件的镜像 （二进制文件）是应烧写到器件中的数据。它和标准操作中 MPLAB IDE
及 MPLAB PM3 之间传送的连续数据块相同。还带有错误检测机制。

    编程器
  设置

PM3 文件

（*.pm3）

器件存储器
镜像
（*.bin）

可选 SQTP
文件
（*.num）

其他文件
（*.txt 和
*.hex 等等）

环境
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6.2.1 在 MPLAB PM3 卡上创建 MPLAB PM3 环境

环境可在 MPLAB IDE 中创建，并保存到 MPLAB PM3 卡、硬盘驱动器或其他存储器
件中。可创建多个环境，每个有其唯一的名称和设置。创建并保存环境时，环境文件
和所有相关文件都保存在同一文件夹中。

要用 MPLAB IDE 在 MPLAB PM3 卡上创建和保存 MPLAB PM3 环境：

1. 打开工作区或将十六进制文件导入 MPLAB IDE。更多信息请参见 MPLAB IDE
在线帮助。

2. 如果 MPLAB PM3 编程器尚未使能，请选择 Programmer>Enable Programmer
以使能编程器。

3. 选择 Configure>Select Device 以打开 Select Device 对话框。选择要为之创建环
境的器件。（更多信息，请参见第 2.5.4 节 “在 MPLAB IDE 中选择器件”。）

4. 选择 Programmer>Settings 以配置 MPLAB PM3 编程器的设置，例如存储器范
围、电压或 SQTP。（更多信息，请参见第 7.5 节 “编程器设置”。）完成后，
请单击 OK 以关闭 Programmer 对话框。

5. 选择 Programmer>Environment>Save 以打开 Save Environment （保存环境）
对话框 （图 6-2）。

图 6-2： SAVE ENVIRONMENT 对话框
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6. 在 Environment Name （环境名）字段中输入环境的名称。环境名最多可有 127
个字符。

7. （可选）单击 Misc. Files 字段中的 Browse 并选择最多 10 个您希望和该 “环
境”关联的文件 （.txt 和 .hex 等）。

8. （可选）在 Description （说明）字段中输入简短说明。

9. 单击 Destination （目标）字段中的 Browse 并选择 MPLAB PM3 CARD
（MPLAB PM3 卡）作为目标。

10. 单击 OK 以关闭 Environment Destination （环境目标）对话框。

11. 单击 Save 将环境保存到 MPLAB PM3 卡。成功创建后， Output 窗口将显示
Environment Name has been created（环境名已创建）。

12. 单击 Close 以关闭 Save Environment 对话框。

6.2.2 将 MPLAB PM3 环境载入到 MPLAB PM3 编程器

您可通过 MPLAB IDE 软件或在独立模式下将环境从 MPLAB PM3 卡载入 MPLAB 
PM3 编程器。

6.2.2.1 用 MPLAB IDE 载入环境

1. 确保 MPLAB PM3 卡完全插入到了 MPLAB PM3 编程器背面的 SD-MMC 卡插槽
中，编程器已上电并已通过 MPLAB IDE Programmer 菜单使能。

2. 从 MPLAB IDE 主菜单选择 Programmer>Environment>Load （载入）以打开
Load Environment （载入环境）窗口。

3. 展开 MPLAB PM3 Card 目录显示要载入编程器中的 *.pm3 文件。

4. 选择要载入的 *.pm3 文件并单击 OK。

5. 完成后， Load Environment 窗口将关闭，并在 Output 窗口中显示完成消息。

6.2.2.2 用独立模式载入环境

1. 确保 MPLAB PM3 卡完全插入到了 MPLAB PM3 编程器背面的 SD-MMC 卡插槽
中，并且编程器已上电。

2. 从 MPLAB PM3 主菜单中选择 MPLAB PM3 Card 并按 <ENTER>。
3. 从 MPLAB PM3 Card 菜单中选择 Load an Environment （载入环境）并按

<ENTER>。
4. 从 PM3CARD:\*.pm3 菜单中选择您的环境文件夹并按 <ENTER>。
5. 从您的环境文件夹选择 Environment.pm3，并按 <ENTER>。

注： 目标也可以是硬盘驱动器或其他存储器件。
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6.3 MPLAB PM3 卡

MPLAB PM3 卡是 MMC 卡格式，基于 FAT16 文件系统，可通过外部读卡器读取。
MPLAB IDE 可通过串口和 USB 接口与 MPLAB PM3 卡通信。 MPLAB PM3 卡也可以
通过 MPLAB IDE 软件或工作在独立模式的 MPLAB PM3 编程器访问。

6.3.1 通过 MPLAB IDE 访问 MPLAB PM3 卡

通过 MPLAB IDE Programmer 菜单，您可以对 MPLAB PM3 卡执行以下操作：

• List files （列出文件）——显示 PLAB PM3 卡上的文件列表。

• Format（格式化）——将 MC 卡格式化为 FAT16 格式。该操作将擦除 MPLAB PM3
卡上存储的任何数据，并将卡格式化为标准 FAT16 格式。

• Properties（属性）——显示 PLAB PM3 卡的属性，包括卡容量、空余字节数、已
用字节数和簇大小。

有关详细说明，请参见第 9.3 节 “通过 MPLAB IDE 访问 MPLAB PM3 卡”。

6.3.2 通过 MPLAB PM3 编程器访问 MPLAB PM3 卡

在独立模式下，您可以对 MPLAB PM3 卡执行以下操作：

• View Disk Contents——在 MPLAB PM3 LCD 屏幕上显示 MPLAB PM3 卡的内容。

• Open a text File (*.txt)（打开文本文件（*.txt））——在编程器的 LCD 屏幕上显示
所选文本文件的大约头十行。

• Load an Environment——将 PLAB PM3 卡上存储的选定“环境”载入到 MPLAB 
PM3 编程器中。

• View an Environment——显示包括器件、存储器文件和 MPLAB PM3 卡上存储的
环境的说明等信息。

• Card Properties——显示 MPLAB PM3 卡的属性，包括卡容量、空余字节数、已用
字节数和簇大小。

有关详细说明，请参见第 9.4 节 “以独立模式使用 MPLAB PM3 卡”。
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注：
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第 7 章  MPLAB PM3—MPLAB IDE 参考信息

7.1 简介

本章说明 MPLAB PM3 开发系统的对话框、窗口、菜单和选项。本章讨论的主题包
括：

• MPLAB PM3 工具栏

• Configure 菜单

• 关于 MPLAB PM3 编程器的菜单

• 编程器设置

• 特殊编程

• MPLAB PM3 使用的文件

• 升级 MPLAB PM3 操作系统

7.2 MPLAB PM3 工具栏

MPLAB PM3 工具栏（图 7-1）由某些编程器功能和编程统计信息显示的图标组成。

图 7-1： MPLAB® PM3 工具栏
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将鼠标指针放在工具栏项目上可显示名称。表 7-1 列出了工具栏上的项目。

表 7-1： MPLAB® PM3 工具栏命令

7.3 CONFIGURE 菜单

Configure 菜单是和 MPLAB PM3 编程器的菜单一起使用的 MPLAB IDE 菜单。有关详
细信息，请参见 MPLAB IDE 文档。 Configure 菜单由表 7-2 中列出的五个对话框选择
组成。

表 7-2： CONFIGURE 菜单

符号 命令 说明

Blank Check All 检查器件是否完全空白 （所有位都设置为 1）。还将检查所
有配置位是否都设置为 1（未编程状态）。（和
Programmer>Blank Check All 功能相同。）

Read 读取器件。（和 Programmer>Read 功能相同。）

Program 对器件编程。（和 Programmer>Program 功能相同。）

Verify 校验器件编程是否正确。（和 Programmer>Verify 功能相
同。）

Erase Flash Device 擦除闪存器件上的所有存储单元。（和 Programmer>Erase 
Flash Device （擦除闪存器件）功能相同。）

Program Statistics 提供尝试的编程次数：已通过、未通过和总数。要清除其中
的值，请选择 Programmer>Reset Program Statistics （将编
程统计复位）。

SQTP File Path 显示带序列号的快速批量编程 （SQTP）文件路径。

选择 说明

Select Device 选择器件。

Configuration Bits 选择器件配置位的值。设置这些值将同时影响调试器和编程器的运行。

External Memory 选择是否使用外部存储器。同时指定外部存储器范围。

ID Memory 将值输入 ID 存储器中。

Settings 输入工作区、调试器、程序装载、热键和项目的默认设置。
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7.4 关于 MPLAB PM3 编程器的菜单

选择 MPLAB PM3 编程器后，将显示完整的编程器菜单（见表 7-3）。必须使能编程
器，才能使其他选项可用。某些 MPLAB PM3 选项可通过 MPLAB PM3 工具栏访问。

表 7-3： MPLAB® PM3 菜单

选择 说明

Select Programmer 列出可用的编程器。

Enable Programmer 使能编程器。

Disable Programmer 禁用编程器。

Program 将十六进制数据文件传输到编程器，并对器件编程。有选择地编
程 （例如部分程序存储器或仅配置位）可用下面的编程器
Settings 选项配置。

Verify 校验器件编程是否正确。

Read 读取器件内容。有选择地读取 （例如部分程序存储器或仅器件的
配置位）可通过设置下面的 Settings 实现。

Blank Check All 检查器件是否完全空白 （所有位都设置为 1）。还将检查所有配
置位是否都设置为默认值。

Blank Check OTP 该功能适用于出厂时配置位已编程的 OTP 器件。使用该功能前，
设置显示的配置位，使之符合出厂编程设置。该功能检查所有程
序存储器位是否都设置为 1，并且配置位和 Configuration Bits 对
话框中显示的值是否匹配。

Erase Flash Device 擦除闪存器件上的所有存储单元。

Reset Program Statistics 将 Program Statistics 区域中的计数器复位。

Transfer to MPLAB PM3 将 MPLAB IDE 的存储器镜像传输到编程器，但不对器件编程。
这对独立运行很有用。

Transfer from MPLAB PM3 将编程器的存储器镜像传输到 MPLAB IDE，但不读取器件存储
器。这对于独立模式工作时读回存储器很有用。

Establish
Communications

将编程器硬件复位，并重新建立通信。如果编程器电源断开了，
请使用该选项。该选项不会将 Program Memory 窗口、配置位或
ID 中的编程信息复位。

Load SQTP File 允许用户选择先前定义的 SQTP 文件。请参见使用 SQTP。
About 显示 MPLAB PM3 的操作系统工具包版本。

Environment 显示可在环境上执行的操作的子菜单。有关环境操作的更多信
息，请参见第 9 章 “MPLAB PM3 卡参考信息”。

MPLAB PM3 Card 显示 MPLAB PM3 卡操作的子菜单。有关 MPLAB PM3 卡操作
的更多信息，请参见第 9 章 “MPLAB PM3 卡参考信息”。

Settings Programmer 对话框将打开，允许您设置存储器范围、电压规
范、 SQTP 和通信端口。编程器选项 Program、 Read、 Verify、
Transfer to MPLAB PM3 和 Transfer from MPLAB PM3 在复位前
限于这些设置。



MPLAB® PM3 用户指南

DS51464C_CN 第 58 页  2006 Microchip Technology Inc.

7.4.1 Select Programmer

要选择 MPLAB PM3 编程器，请选择 Select Programmer>MPLAB PM3。选择编程器
后，将打开 Output 窗口。

7.4.2 Enable Programmer

要使能 MPLAB PM3 编程器，请选择 Programmer>Enable Programmer。
如果编程器固件有更新， MPLAB IDE 将显示更新提示。如果 Configuration 对话框中
设置了自动下载， MPLAB IDE 将自动更新必要的文件。

选择 MPLAB PM3 编程器后，将显示完整的菜单。使能编程器后将有更多菜单项可
用。某些 MPLAB PM3 菜单项和 MPLAB PM3 工具栏上的按钮类似。

7.4.2.1 OUTPUT 窗口

从 MPLAB PM3 菜单选择 Programmer>Select Programmer>MPLAB PM3 或从
MPLAB IDE 菜单选择 View>Output 后，将打开 Output 窗口。该窗口以选项卡形式包
含有关程序输出的信息。有关更多信息，请参见 MPLAB IDE 文档。

Output 窗口中通过鼠标右键菜单可用的菜单项有：

• Select All （全选）——选择编辑窗口中的所有文本和图形。

• Copy——将当前窗口中选定的文本复制到剪贴板。执行本操作后，将复制的文本
粘贴到另一个 MPLAB 编辑器窗口、同一个 MPLAB 编辑器窗口中的其他位置或另
一个 Windows 应用程序中。

• Clear Page （清除页面）——清除 Output 窗口的内容。

7.4.2.2 PROGRAM MEMORY 窗口

从 MPLAB IDE 菜单选择 View>Program Memory 后，将以机器码视图打开 Program 
Memory 窗口 （图 7-2）。

图 7-2： PROGRAM MEMORY 窗口



MPLAB PM3—MPLAB IDE 参考信息

 2006 Microchip Technology Inc. DS51464C_CN 第 59 页

您可以用十六进制代码、机器码或反汇编的符号 （如果可以）查看程序存储器。通过
单击窗口左下角的显示选项按钮可更改显示模式。

选择 MPLAB ICE 仿真器作为调试器时，Program Memory 窗口将显示 MPLAB ICE 主
机的仿真存储器中的数据。该存储器用仿真器运行、单步运行或跟踪时由 MPLAB ICE
主机读取。

选择软件模拟器作为调试器时， Program Memory 窗口反映 PC 上存储缓冲区的内容。
该存储器在运行、单步运行或跟踪时由 MPLAB SIM 读取。

如果在仿真器或软件模拟器模式下用 MPLAB PM3 编程器读取程序存储器，它将覆盖
正被仿真或模拟的程序存储器。如果打开了 MPLAB IDE 项目，这可能导致程序存储器
和调试信息之间“不匹配”。系统显示关闭当前 MPLAB IDE 项目或继续将该器件的存
储器读入 Program Memory 窗口的选项。后续调试操作可能无法正常进行。

7.4.3 Disable Programmer

要禁止 MPLAB PM3 编程器，请选择 Programmer>Disable Programmer。

7.4.4 Program

选择 Programmer>Program 以对整个器件 （即所有程序存储器和配置位等）编程。

如果要有选择地编程 （例如，程序存储器的一部分或仅配置位），请选择
Programmer>Settings 以打开 Programmer 对话框。单击 Memory Ranges 选项卡，
并选择编程的选项。灰掉的区域在该器件上不可用。单击 OK。然后选择
Programmer>Program 对器件编程。对应于所选复选框的存储器区域将被编程。

MPLAB PM3 对器件编程后，将自动执行校验操作，并显示发现的任何错误。另一种
校验操作可通过选择 Programmer>Verify 执行。

7.4.5 Verify

要校验对该器件的编程，请选择 Programmer>Verify。这将校验对器件的编程与
MPLAB IDE、 Programmer 对话框及 Configuration Bits 对话框中的程序存储器、配置
位、 ID 存储单元、 EEPROM 以及校准存储器值是否匹配。

如果错误个数超出预期，并且这些错误称错误数据是全零 （0000），插座模块可能没
有正确安装到位。拔出并重新安装插座模块。每当更换插座模块时总是插入已知的空
白器件进行空白检查，是一种好习惯。

编程完成时， Output 窗口中将显示 Programming/Verification completed 
successfully!（编程 / 校验已成功完成！）。如果编程失败，将出现错误消息，显
示它试图编程的每个地址的好的 （期望）数据和错误 （实际）数据。
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7.4.6 Read

要从已编程的 PIC MCU 器件将固件复制到未编程器件中，请将已编程固件 （程序存
储器和配置位等）读取到 MPLAB IDE 中，然后根据这些信息对新器件编程。

要读取整个器件 （即所有程序存储器和配置位等），请单击 Programmer>Read。
要有选择地读取 （例如，程序存储器的一部分或仅配置位），请选择
Programmer>Settings>Memory Ranges 以显示 Memory Ranges 对话框。选择要读取
的选项，然后单击此对话框中的 OK。灰掉的区域在该器件上不可用。然后，选择
Programmer>Read。对应于所选复选框的存储器区域将被读取。

读取完成后， Program Memory 窗口将显示从主器件读取的数据。将这些数据保存为
十六进制文件，并将新器件插入 MPLAB PM3 中，从而将相同数据复制到新器件中，
或在保存到十六进制文件或对其他器件编程前在 MPLAB IDE 中修改数据。

如果尝试读取代码保护的器件，将收到一条警告，说该器件是代码保护的，程序存储
器可能无效。如果出现这种情况，请从文件或未代码保护器件获取原始十六进制代码。

如果 MPLAB IDE 连接有 MPLAB ICE 仿真器，您的代码将下载到 MPLAB ICE 的仿真
程序存储器。如果有打开的项目，系统将问您是否要在从器件读存储器之前关闭它。

7.4.7 Blank Check All

将器件插入插座后，从 MPLAB PM3 菜单选择 Programmer>Blank Check All。该检查
将校验器件是否完全空白 （所有位都设置为 1）并且所有配置位是否都设置为默认
值。

完成后，结果将显示在 Output 窗口中，例如：

Configuration memory is blank.

EEData memory is blank.

ID memory is blank.

Program memory is blank.

如果使用一次编程 （OTP）器件，某些配置位 （如振荡器位）可能已在出厂时就编程
了。确保配置位设置为出厂值，并选择 Programmer>Blank Check OTP。这将检查所
有程序存储器位是否都设置为 1，并且配置位是否与对话框中的值匹配。 OTP 器件不
能擦除和再编程。

注： 如果保持项目打开，绝对列表窗口和源代码窗口可能与先前读入 Program 
Memory 窗口的数据不匹配。符号可能与 Program Memory 窗口中的正确
地址不匹配。



MPLAB PM3—MPLAB IDE 参考信息

 2006 Microchip Technology Inc. DS51464C_CN 第 61 页

如果 EPROM 器件不是空白的，要在编程前对其进行编程，或者选择其他器件。

1. 除去覆盖在器件窗口上的任何标签。非窗口器件不能再编程。所有 EPROM 器
件的窗口版本可通过请求 JW 封装订购。

2. 将器件放入紫外线 （UV） EPROM 擦除器中。完全擦除紫外线可擦除器件所需
的时间取决于：紫外线的波长、强度、到紫外线源的距离以及器件的工艺技术
（存储单元的尺寸）。

3. 尝试对器件编程前，请再次执行空白检查以检查器件是否是空白的。

7.4.8 Erase Flash Device

将器件插入插座后，请从 MPLAB PM3 菜单选择 Programmer>Erase Flash Device。
随后，从 MPLAB PM3 菜单选择 Programmer>Blank Check All。该检查将检查器件是
否完全空白 （所有位都设置为 1）并且所有配置位是否都设置为默认值。

7.4.9 Reset Program Statistics

要将编程统计复位，请选择 Programmer>Reset Program Statistics。该命令将把
Program Statistics 区域的计数器复位。

7.4.10 Transfer to MPLAB PM3

要将十六进制文件传输到编程器，请选择 Programmer>Transfer to MPLAB PM3。该
命令只传输数据，不对器件编程。这通常用于独立运行。

7.4.11 Transfer from MPLAB PM3

要将编程器存储器传输到十六进制文件，请选择 Programmer>Transfer from MPLAB 
PM3。该命令只传输编程器存储器，不读取器件存储器。这对于以独立模式工作时读
回编程器存储器特别有用。

7.4.12 Establish Communications

编程器断电后要建立 PC 和 MPLAB PM3 之间的通信，请选择 Programmer>Establish 
Communications。该命令将把编程器硬件复位，并重新建立通信。该选项不会将
Program Memory 窗口、 Configuration bits 或 ID 中的编程信息复位。

7.4.13 About

选择 Programmer>About 以显示编程器中 MPLAB PM3 操作系统工具包的版本信息。

注： 如果器件是 EEPROM 或闪存，无需在再编程前擦除它。这些器件在编程
前会被电擦除。
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7.5 编程器设置

选择 Programmer>Settings 以显示 Programmer 对话框。

• Memory Ranges 选项卡

• Voltages 选项卡

• SQTP 选项卡

• Communications 选项卡

• Configuration 选项卡

7.5.1 Memory Ranges 选项卡

选择 Programmer>Settings 并单击 Memory Ranges 选项卡以选择要编程的器件存储
器区域 （见图 7-3 和表 7-4）。

图 7-3： MEMORY RANGES 选项卡
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7.5.2 Voltages 选项卡

选择 Programmer>Settings 并单击 Voltages 选项卡以查看或设置器件的电压 （见
图 7-4）。

图 7-4： VOLTAGES 选项卡

表 7-4： MEMORY RANGES 选项

选择 说明

Program Memory Start Address 输入程序存储器范围的起始地址 （十六进制）。

Program Memory End Address 输入程序存储器范围的结束地址 （十六进制）。

Reset Addresses 单击该按钮将程序存储器地址复位。

Program Memory 如果要对程序存储器编程，请选中此复选框。程序存储
器范围由程序存储器起始和结束地址字段确定。

Configuration Bits 如果要对配置存储区编程，请选中此复选框。

ID Location 如果要对 ID 存储单元编程，请选中此复选框。

EEPROM Data 如果要对 EEPROM 数据存储器编程，请选中此复选框。

Calibration Memory 如果要对校准存储区编程，请选中此复选框。 
Erase All Before Program 如果要在编程前擦除该器件，请选中此复选框。
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可针对闪存器件 （见表 7-5）和非闪存器件 （见表 7-6）查看 / 设置某些电压。另一些
电压同时适用于这两种类型的器件 （见表 7-7）。关于更改电压设置和使用低电压编程
的信息，请分别参见第 7.5.2.1 节 “更改电压设置”和第 7.5.2.2 节 “使用低电压编
程”。

表 7-5： 闪存器件

选择 说明

VDD APP 这是编程器用来校验闪存存储器的电压。默认值是器件的标
称电压值。

表 7-6： 非闪存器件

选择 说明

VDD Min 该电压和 VDD Max 是编程器用来校验 EEPROM 器件中存储
器的电压。该值应为指定电路的最低电压。默认值是器件的
最低电压值。

VDD Max 该电压和 VDD Min 是编程器用来校验存储器的电压。该值应
为指定电路的最高电压。默认值是器件的最高电压值。

表 7-7： 所有器件

选择 说明

VDD Nom 这是对器件进行编程的电压值。这应是系统运行的平均电
压。默认值是 5 伏。

VPP 这是用于使器件进入编程模式的电压。尽管它取决于器件
的编程规范，但也可更改。如果选择了 Low Voltage 
Program，编程器将把它更改为为 VDD Nom。

Reset Voltages （复位电压） 将所有电压恢复到默认值。

Low Voltage Program 在 ICSP™ 模式下，选中该复选框执行低电压编程。低电压
编程使用专用引脚进入编程模式，不使用 VPP 上的高电压。
如果安装了插座，将忽略该复选框。

Power Target Circuit from 
MPLAB PM3

在 ICSP 模式下，该选项允许目标电路通过 MPLAB PM3 供
电以获得编程所需的电源。如果安装了插座，将忽略该复选
框。
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7.5.2.1 更改电压设置

仅当应用程序运行在极限工作电压范围时才需更改电压设置。多数用户不需要更改默
认电压设置。

• 闪存器件：VDD APP 是校验闪存器件的电压。

• 非闪存器件：VDD MAX 和 VDD MIN 用于校验已编程单片机的电压。

• VDD NOM 是对器件进行编程的电压。

• VPP 是使器件进入编程模式的电压。

选择 Programmer>Settings 并单击 Voltages 选项卡以显示当前的电压设置。要更改
电压，请从每个设置旁的列表选择想要的 VDD 最小值、标称值、最大值或 VPP 电压
值。

表 7-8： 电压设置

7.5.2.2 使用低电压编程

Voltages 选项卡下的 Low Voltage Program 复选框的作用如下：

• 仅当选中了能低电压编程的闪存器件时才被使能。

• 所作的选择将通过执行 Blank Check、 Read、 Program、 Verify 或 Transfer to 
MPLAB PM3 从 MPLAB IDE 传输到 MPLAB PM3。从编程器传输不会更新
MPLAB IDE 中的复选框。

• 低电压复选框的设置对低电压配置位的使能 / 禁止没有影响。

• 仅在 ICSP 模式下执行低电压编程。请参见第 7.6.2.1 节 “使用低电压编程”。

注： 对每个单片机类型，电压范围和默认电压设置可能是不同的。关于每个器
件的电压值，请参见器件编程规范。

电压 选择 默认电压

VDD APP (2.00 .. 5.5) 5.00
VDD MIN (2.00 .. 5.5) 3.00 
VDD MAX (2.00 .. 5.5) 5.50
VDD NOM (2.00 .. 5.5) 5.00
VPP (12.5 .. 13.5) 13.25
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7.5.3 SQTP 选项卡

用带序列号的快速批量编程 （SQTP）将唯一的序列号烧写到每个器件中。该编号可
用作记录码、密码或 ID 号。

选择 Programmer>Settings 并单击 SQTP 选项卡以查看或设置器件的 SQTP 编程
（图 7-5）。另请参见第 7.6.1 节 “使用 SQTP”。

图 7-5： SQTP 选项卡

表 7-9： SQTP 菜单

选择 说明

Random （随机） 选择该选项为每个部件生成唯一的随机编号。

Pseudo-Random （伪随机）
Seed Value (Hex) （种子值
（十六进制））

选择该选项可根据指定的种子值生成不重复的一组伪随机编
号。 

Sequential （连续）
Start Value (Hex) （起始值
（十六进制））
Increment (Hex) （增量 （十六
进制））

选择该选项将根据指定的起始值且每个编号比前面的编号
增加指定的量，生成连续的一组编号。

Start Address (Hex) （起始地
址 （十六进制））

输入序列号的起始地址（十六进制）。

Number of Words (Dec) （字数
（十进制））

输入序列号的长度。确保为要使用该文件编程的部件数指定
足够大的序列号。

Number of Parts (Dec) （部件
数 （十进制））

输入要使用该文件编程的部件数。

Generate （生成） 打开 Save SQTP File As （将 SQTP 文件保存为）对话框。
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7.5.4 Communications 选项卡

要设置编程器和 PC 之间的通信端口，请选择 Programmer>Settings 并单击
Communications 选项卡。编程器和 PC 之间的通信既可以通过串行连接，也可以通
过 USB 连接。

Windows COM 端口设置需要特别注意。必须安装正确的驱动程序，并且可能需要手
动设置端口。有关通信端口设置的更多信息，请参见第 2.3.1 节 “安装通信电缆”、第
2.5 节 “为使用 MPLAB PM3 配置 MPLAB IDE”和 B.5.1 “无法与编程器建立通
信”。

7.5.4.1 串行通信

要在 PC 和 MPLAB PM3 器件编程器之间使用 RS-232 （串行）通信，请选择要使用
的 PC COM 端口 COM1、 COM2、 COM3 或 COM4 （图 7-6）。默认为 COM1。单击 OK。

图 7-6： 串行 COM 口

要确保端口设置正确，请按照第 2.3.1 节 “安装通信电缆”中 “对于 RS-232 通信”
部分的说明进行操作。

注： 不要同时进行这两种物理连接。
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7.5.4.2 USB 通信

要在 PC 和 MPLAB PM3 器件编程器之间使用 USB 通信，请选择 USB 端口（图 7-7）。
单击 OK。

图 7-7： USB 端口

要确保端口设置正确，请按照第 2.3.1 节“安装通信电缆”中“对于 USB 通信”部分
中的说明进行操作。

7.5.4.3 切换通信模式

如果 MPLAB PM3 是在一种通信模式 （USB 或串行）下使能的，而您希望切换到另一
种模式，请执行以下操作：

1. 在 MPLAB IDE 中取消选择编程器 （Programmer>Select Programmer>None
（无））。

2. 关闭 MPLAB PM3 编程器，并改变通信电缆的物理连接。如果尚未安装驱动程
序，请安装正确的驱动程序。

3. 将 MPLAB PM3 编程器重新打开。

4. 重新选择编程器 （Programmer>Select Programmer>MPLAB PM3）。
5. 选择另一种通信模式 （Programmer>Settings， Communications 选项卡）。

6. 使能编程器 （Programmer>Enable Programmer）。

警告

不要让 Windows 操作系统选择 USB 驱动程序。按照第 2.2 节“安装 MPLAB PM3 的

软件”中指定的步骤操作。
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7.5.5 Configuration 选项卡

7.5.5.1 AUTOMATIC DOWNLOAD

要设置 MPLAB PM3 自动下载任何固件更新，请选择 Programmer>Settings 并单击
Configuration 选项卡 （图 7-8）。然后选中 Auto Download Firmware （自动下载固
件）复选框，这样启动 MPLAB PM3 时会自动下载新的固件。

图 7-8： CONFIGURATION 选项卡

如果不希望自动下载固件更新，请保留复选框空白。如果有更新，系统会提示您下载。
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7.5.5.2 MANUAL DOWNLOAD （手动下载）

建议让 MPLAB PM3 自动检测任何升级并通知。通常情况下，无需为 MPLAB PM3 编
程器手动更新操作系统工具包；但是如果需要恢复到较早的操作系统工具包版本，请
选择 Programmer>Settings 并单击 Configuration 选项卡。然后单击 Manual 
Download 按钮。如果选中该选项，系统将用自动更新通知提示您（图 7-9）。要继续下
载，请单击 Yes，否则请单击 No 取消。

图 7-9： 手动下载

单击 Yes 将打开 Browse 窗口，您可从 MPLAB IDE 目录中选择适当的文件。操作系
统工具包文件的格式为 pm3nnnnnn.mjc，其中 nnnnnn是操作系统工具包的版本。

7.6 特殊编程

7.6.1 使用 SQTP
器件的序列号生成是通过一系列 RETLW（从子程序返回，并将立即数存储到 W 中）
指令实现的，序列号字节作为立即数数据。要生成序列号，首先必须生成序列号文件，
然后用该文件将序列号烧写到单片机的存储单元中。使用 SQTP 包括以下步骤：

• 生成 SQTP 文件

• 激活序列号

• 对器件编程

请参见第 7.7.1 节 “使用十六进制记录格式”以获取有关十六进制记录格式的信息。
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7.6.1.1 生成 SQTP 文件

1. 选择 Programmer>Settings 并单击 SQTP 选项卡以查看或选择 SQTP 设置
（图 7-10）。

图 7-10： SQTP 选项卡

2. 针对 SQTP 文件类型填入适当值。

3. 单击 Generate。 Save SQTP File As 对话框将打开。

4. 为文件选择路径和文件名，并单击 Save。
每个部件在 SQTP 文件中都有一行；如果指定了 1,000 个部件或器件，文件将
包含 1,000 行，每行都有一个唯一的序列号。

表 7-10： SQTP 菜单

选择 说明

Random 选择该选项为每个部件生成唯一的随机编号。

Pseudo-Random
Seed Value (Hex)

选择该选项可根据指定的种子值生成不重复的一组伪随机编
号。 

Sequential
Start Value (Hex)
Increment (Hex)

选择该选项将根据指定的起始值且每个编号比前面的编号增加
指定的量，生成连续的一组编号。

Start Address (Hex) 输入序列号的起始地址 （十六进制）。

Number of Words (Dec) 输入序列号的长度。确保为要使用该文件编程的部件数指定足
够大的序列号。

Number of Parts (Dec) 输入要使用该文件编程的部件数。

Generate Save SQTP File As 对话框将打开。
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7.6.1.2 激活序列号

选择 Programmer>Load SQTP File 以选择要使用的 SQTP 文件。单击 Open 以使能
当前编程会话的序列号生成。

使能序列号生成后，将烧写到下个器件中的序列号可在生成 SQTP 文件时指定的程序
存储器地址处看到。在 Program Memory 窗口中查找 RETLW指令。

7.6.1.3 对器件编程

载入 SQTP 文件后，只需选择 Programmer>Program 即可对器件编程。对器件编程
后， Program Memory 窗口将显示下个序列号。如果文件中上个序列号已使用，将显
示一条消息并禁止序列号生成。

使用序列号时， SQTP 文件将通过把该条目的冒号替换为分号作标记，使 MPLAB 
PM3 在以后的编程会话中跳过该行。为了在多个编程会话中使用同一个 SQTP 文件而
无需重复任何编号，要生成的 SQTP 文件应具有比单个会话中要编程的部件数量多得
多的部件。例如，如果生成了 10,000 个部件的 SQTP 文件，每个会话中只对 1,000 个
部件编程，该文件可使用十次。

7.6.2 使用 ICSP
MPLAB PM3 配有 ICSP 引脚插头和电缆。将 ICSP 电缆连接到 MPLAB PM3 上两个插
座模块连接器之间的连接器。不能在使用 ICSP 连接时安装插座模块。

7.6.2.1 使用低电压编程

MPLAB PM3 允许对某些 PICXXFXXX 闪存器件进行低电压编程 （LVP）。选择的闪
存器件必须能进行低电压编程，且编程必须在 ICSP 模式下进行。请参见特定器件的
规范和 In-Circuit Serial Programming™ (ICSP™) Guide （DS30277）。

• 所作的选择将通过执行 Blank Check、 Read、 Program、 Verify 或 Transfer to 
MPLAB PM3 从 MPLAB IDE 传输到 MPLAB PM3。从编程器传输不会更新
MPLAB IDE 中的复选框。

• 低电压复选框的设置对低电压配置位的使能 / 禁止没有影响。

注： 由于 MPLAB PM3 有内置的 ICSP，因而不能使用 PRO MATE II ICSP 插座
模块 （AC04004）和 PM3-PROMATE II 器件适配器。
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要使用低电压编程：

1. 用 Configure>Select Device 并选择器件来选择要编程的器件。

2. 选择并使能 MPLAB PM3。
3. 转到 Programmer>Settings 并单击 Voltages 选项卡。

4. 在 ICSP Options 区域，选中 Low Voltage Program 复选框 （图 7-11）。

图 7-11： 低电压编程选项
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7.7 MPLAB PM3 使用的文件

MPLAB PM3 可以直接使用来自 MPLAB IDE 项目的信息，而无需任何中间步骤。可使
用独立于 MPLAB IDE 的 MPASM 汇编器生成供 MPLAB PM3 使用的十六进制文件。
或者也可用由与 PICmicro MCU 兼容的交叉汇编器或交叉编译器生成的任何十六进制
文件对器件编程。

如果使用独立于 MPLAB IDE 的 MPASM 汇编器，或在 MPLAB IDE 内生成以后供
MPLAB PM3 使用的十六进制文件，请使用 INHX8M 或 INHX32 十六进制格式。
MPASM 汇编器的十六进制文件默认输出格式是 INHX32。 
如果对 PIC17CXXX、 PIC18CXXX 或 PIC18FXXX 器件编程，请使用 INHX32 格式。
有关文件格式的详细信息，请参见 《MPASM™ 汇编器、 MPLINK™ 目标链接器和
MPLIB™ 目标库管理器用户指南》（DS33014J_CN）。

7.7.1 使用十六进制记录格式

以下提供了 PICmicro MCU 器件系列的正确文件格式。确保汇编器或编译器配置为生
成正确格式的十六进制文件。 MPLAB PM3 使用表 7-11 中描述的格式。

每个十六进制数据记录都有如下格式：
:BBAAAATTHHHH....HHCC

INHX8M

数据记录按以上所述输出。

INHX32

输出扩展线性地址记录以建立数据地址的高 16 位。

表 7-11： PICmicro® MCU 器件系列文件格式

器件系列 文件格式

PIC16C5X/6X 使用 INHX8M
PIC17CXX 使用 INHX32
PIC18XXX 使用 INHX32
固件下载 使用 INHX32

表 7-12： 十六进制数据记录格式

记录格式 说明

: 起始字符（前缀）

BB 指示记录中数据块数的 2 位字节计数

AAAA 数据记录的 4 位起始地址

TT 2 位记录类型

00 = 数据记录

01 = 文件记录末尾

02 = 段地址记录

04 = 扩展线性地址记录 （INHX32）
HHHH....HH 2 位数据块

CC 2 位校验和。数据记录中除冒号 （起始字符）外所
有前面字节总和的二进制补码。
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7.8 升级 MPLAB PM3 操作系统

在以下情况下可能需要升级 MPLAB PM3 操作系统：

• 使能 MPLAB PM3 时， MPLAB IDE 指示有新版本的 MPLAB PM3 操作系统。

如果使能了 Automatic Update （自动更新）（请参见第 7.5.5 节 “Configuration 选
项卡”），发现升级时 Output 窗口中将显示以下消息：

An upgrade for your MPLAB PM3 has been detected and is being 

downloaded now.（检测到 MPLAB PM3 的升级，正在下载。）

如果禁止了自动更新，将在消息框中显示以下消息，并带有 Yes 和 No 选项：

An upgrade for your MPLAB PM3 has been detected.

Would you like to upgrade now?（检测到 MPLAB PM3 的升级。是否现
在就升级？）

选择 Yes 进行更新，选择 No 不更新。

更新操作系统时，MPLAB PM3 在 MPLAB IDE 更新编程器时，可能会发出嘀嗒声或鸣
叫若干次。

将在 Output 窗口底部显示并持续更新 “Downloading xx to MPLAB PM3: nn% 
Completed”（正在将 xx 下载到 MPLAB PM3：nn% 已完成），其中 xx是 BIOS、操作
系统或数据库，而 nn是 0 到 100 之间的数值。 MPLAB PM3 LCD 上将显示
Downloading Now （正在下载），并在 LCD 的右上角显示活动指示器。下载可能需要
几分钟。

升级完成时， Output 窗口中将显示 Download Complete（下载已完成）消息。
MPLAB PM3 编程器现在可以使用了。

操作系统的更新版本在 MPLAB PM3 目录中。包含最新 MPLAB PM3 操作系统的最
新 MPLAB IDE 版本可从我公司网站 www.microchip.com 获得。单击 Development 
Tools （开发工具）并找到列在 Hardware （硬件）下的 MPLAB PM3。 MPLAB PM3
页面底部附近可找到最新的操作系统更新。
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注：
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第 8 章  独立模式参考信息

8.1 简介

本章说明如何以独立模式使用 MPLAB PM3 器件编程器。该器件编程器提供能够全面
控制编程会话的 LCD 接口。本章讨论的主题包括：

• MPLAB PM3 LCD 和键

• 启动过程

• 主菜单

• 命令菜单

8.2 MPLAB PM3 LCD 和键

编程器的前面板外观类似于图 8-1。

图 8-1： MPLAB® PM3 前面板

8.2.1 LCD

图形化 LCD 是 128 x 64 像素的屏幕，在蓝色背景上显示信息。选择条会高亮显示整
行。在以右向三角形结尾的某行上按 <Enter>，将显示子菜单。在以两个大于号
（>>）结尾的某行上按 <Enter>，将执行操作。

ESC ENTER

STATUS
µÁ‘¥œ?

MPLAB PM3 ®

ICSP™ 连接器

插座模块

LED

LCD

上移

器件编程器

连接器

下移

M
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8.2.2 键

MPLAB PM3 提供四个导航键。每个键的功能是：

• <ESC>——返回到上个菜单或条目。

• <Up>——每按一次，选择条将上移一行。

• <Down>——每按一次，选择条将下移一行。

• <Enter>——执行所选功能。

8.3 启动过程

MPLAB PM3 编程器上电后，将触发启动过程。系统执行自检，短暂显示闪屏，然后
显示版本信息和 MPLAB PM3 主菜单。如果没有进入主菜单，请参见附录 B “疑难解
答”。

启动过程完成后，将看到主菜单：

8.4 主菜单

主菜单有以下选项：

• Recently Used
• Select Device
• Programmer Settings
• Help

8.4.1 Recently Used

要显示最近使用过的器件：

1. 选择 （高亮显示）“Recently Used”选项，并按 <Enter>。将列出最多七个最
近使用过的器件。

2. 要继续使用该器件，请按 <Enter>。
3. 系统将显示命令菜单。请参见第 8.5 节 “命令菜单”。

8.4.2 Select Device

要选择特定器件，必须：

1. 选择 （高亮显示）“Select Device”选项，并按 <Enter>。
2. 选择器件系列，并按 <Enter>。
3. 选择器件并按 <Enter>。
4. 系统将显示命令菜单。请参见第 8.5 节 “命令菜单”。

8.4.3 Programmer Settings

从主菜单上的 Programmer Settings 选项，可访问：

• Screen Contrast
• Buzzer Volume
• Socket Information
• Checksum Calculation
• Device ID Option (Beta)
• Blank Check Override
• Go Pin Functionality

注： 如果需要更新操作系统，必须连接到一台运行 MPLAB IDE 的 PC 方能实
现。
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8.4.3.1 SCREEN CONTRAST

该选项使您能够选择默认、更暗或更亮的设置，以调节屏幕对比度。提供的示例文本
行使您能看到您所作选择的效果。

• Normal （正常）（默认）——要将对比度复位到默认设置，选择 “Default”并按
<Enter> 一次。

• Darker（更暗）——要提高对比度，选择 Darker 并按 <Enter>，直到获得想要的对
比度。

• Lighter（更亮）——要减小对比度，选择 Lighter 并按 <Enter>，直到获得想要的对
比度。

8.4.3.2 BUZZER VOLUME

该选项使您能选择蜂鸣器的音量。

• Loud （响亮）——要使蜂鸣器音量响亮，选择 Loud 并按 <Enter>。
• Medium （中等）（默认）——要返回到默认音量，选择 “Default”并按

<Enter>。
• Low （低沉）——要使蜂鸣器音量低沉，选择 Low 并按 <Enter>。
• Mute （静音）——要使蜂鸣器静音，选择 Mute 并按 <Enter>。

8.4.3.3 SOCKET INFORMATION

该选项显示当前 MPLAB PM3 上安装的插座的插座部件编号以及插座模块的插座 ID。

8.4.3.4 CHECKSUM CALCULATION

通过该选项，您可以使能或禁止代码保护器件的校验和计算。从主菜单选择该菜单项
后，将显示一条消息，问您是否要计算校验和，说明当前设置并提供两个选项 （见图
8-2）。

图 8-2： CHECKSUM CALCULATION 屏幕

默认设置是 “Do Not Calculate”。编程器电源断开时将保存设置。

选择 Calculate Checksum 选项在对较大的代码保护器件 （如 PIC18F8720）编程或校
验时可以节省时间，因为不会重读整个器件。

如果将校验和计算选项设置为 Do Not Calculate 并成功地对代码保护的器件进行了
编程，屏幕上将显示 “Passed!Protected csum disabled”（已通过！受保护的 csum
已禁止）。

如果将校验和计算选项设置为 Do Not Calculate 但未成功对代码保护的器件进行编程，
屏幕上将显示 “Failed! CP sum disabled”（失败！ CP sum 已禁止）。

                 Checksum Calculation
---------------------------------------------------------
Would you like to calculate the Code Protected Checksum

Currently:No

Do Not Calculate   　　　　                               >>
Calculate Checksum   　　　　　　                          >>
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如果对一个代码保护的器件，将校验和计算选项设置为 Calculate Checksum，显示的
校验和将带有编程或校验操作的结果。

8.4.3.5 Device ID Option (Beta)

该选项检查所选器件是否插入到了插座模块中。选择该菜单项后，将显示一条消息，
问您是否要检查器件 ID，说明当前设置并提供两个选项 （见图 8-3）。

图 8-3： DEVICE ID OPTION 屏幕

默认设置是 “Don't Test Device Ids” （Currently:No）编程器电源断开时将保存设
置。

选择 “Test Device Ids”选项将校验通过 MPLAB PM3 选择的器件是否与插座模块上
安装的器件相匹配。这有助于避免对错误的器件编程。设置 “Test Device Ids”选项
时，“Currently:”显示变为 Yes。

8.4.3.6 BLANK CHECK OVERRIDE

选择该选项将禁止在对 EEPROM 或 C 器件编程前进行空白检查。选择该菜单项后，
将显示一条消息，问您是否要覆盖 “空白检查”，说明当前设置并提供两个选项
（见图 8-4）。

图 8-4： BLANK CHECK OVERRIDE 屏幕

默认设置是 “Blank Check 'C' devices”（Currently: Yes）。编程器电源断开时将保存
设置。

选择 “Override Blank Check”能无需首先检查 C 器件是否空白就对它们编程。设置
“Override Blank Check”选项时，“Currently:”显示变为 No。
如果 C 器件已预编程时该设置很使用，例如预编程了振荡器值。在这种情况下，如果
执行了空白检查，器件将不能通过空白检查，因为 MPLAB PM3 会检测到预编程的设
置。使用覆盖设置在这些情况下很有用。

                 Device Id Option
---------------------------------------------------------
Would you like to check device ids?
Currently:No

Test Device Ids　　　　　　　                                  >>
Don’t Test Device Ids　　　　　　　　                        >>

                 Blank Check Override
---------------------------------------------------------
Blank check before programming 'C' devices?

Currently:Yes

Blank Check 'C' devices　　　　　　　　　　　              >>
Override Blank Check                                                  >>
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8.4.3.7 GO PIN FUNCTIONALITY

该选项允许用户更改 go 引脚的功能。选择该菜单项后，将显示一条消息，说明当前设
置并提供四个选项 （见图 8-5）。

图 8-5： GO PIN FUNCTIONALITY 屏幕

默认设置是“Use as PgmVfy”（Currently: as Program Verify）。编程器电源断开时将
保存设置。

该功能在要求处理器件速度很快的生产线上特别有用。它允许在器件上执行重复的操
作，因为这些操作将自动载入编程器 / 从编程器卸载。每次器件载入时，都会激活 Go
引脚并执行预设操作。

“Currently:”将发生变化，以反映所选的选项。

8.4.4 Help

该选项显示 MPLAB PM3 上运行的 MPLAB PM3 操作系统工具包的版本号。它还包含
以下子菜单选项：

• ICSP Connector Pinout （ICSP 连接器引脚排列）——显示 ICSP 连接器图并具有
一个查看引脚定义的选项。所有 ICSP 引脚的定义都将按编号、颜色和信号列出。
请参见第 A.4.1 节 “ICSP 插头和电缆引脚排列”。

• Status Bar Icons （状态栏图标）——显示以下图标和定义：

- I——ICSP 模式

- T——目标已上电

- V——LVP 编程入口

- Q——SQTP 文件已装载

- O——选项设置

- R——范围 / 区域设置

• About——显示产品和制造商名称，并具有一个查看版本信息的选项。还将列出和
MPLAB PM3 相关的程序的版本信息。

选项 操作

Use as PgmVfy 对器件进行编程及校验

Use as Verify 对器件进行校验

Use as Erase 擦除器件

Use as Blank Check 对器件进行空白检查

                 Go Pin Functionality
---------------------------------------------------------

Use as Erase   　　　　　　　                                >>
Use as Blank Check                                                        >>

Use as PgmVfy    　　   　　　　　　　　                      >>
Use as Verify     　　　　　                                >>

Currently:
as Program Verify
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8.5 命令菜单

选择器件后，器件编程器将显示命令菜单：

• Program Verify Device
• Verify Device
• All Functions

命令菜单上的功能允许您执行对单片机编程的基本用户任务。重复按 <ESC> 可回到主
菜单。

8.5.1 Program Verify Device

Program Verify Device 选项对器件执行擦除 （如果是闪存器件）、编程和校验操作
（见第 8.5.3.7 节 “Settings”）。

8.5.2 Verify Device

校验器件编程是否正确。

8.5.3 All Functions

All Functions 选项将显示一个子菜单，其中的选项请见表 8-1：

8.5.3.1 READ DEVICE

如果要从已编程的器件将固件复制到未编程器件中，可将已编程固件读取到 MPLAB 
PM3 存储器中，然后根据这些信息对新器件编程。选择 Read Device 将插座模块中的
器件内容复制到器件编程器的内部存储器中。

对于 PIC16CXX 器件，器件编程器将询问问题：“Code Protect Parts?”（对部件进行
代码保护吗？）。回答 Yes 将对要编程的部件进行代码保护。直到读取新器件，代码
保护都将保持有效。回答 No 将严格按读取内容对器件编程。

读取器件后，器件编程器将显示校验和。如果器件被代码保护，将在读取前显示代码
保护消息。回答 Yes 继续。回答 No 返回到命令菜单。

表 8-1： ALL FUNCTIONS 菜单

选择 说明

Read Device 读取器件内容。有选择地读取 （例如部分程序存储器或仅器件的
配置位）可通过设置下面的 Settings 实现。

Program Verify Device 对器件进行编程及校验。

Verify Device 校验器件编程是否正确。

Blank check device 检查器件是否完全空白 （所有位都设置为 1）。还将检查所有配
置位是否都设置为 1（未编程状态）。

Erase Device 在 MPLAB® PM3 器件编程器中擦除器件。该选项仅对可擦除器
件显示。

Device Information 显示器件名、器件 ID、器件版本、上次校验和以及用户 ID。

Settings 设置编程 / 校验选项、 ICSP™ 设置、调节电压、复位电压、复
位统计计数及安全模式。
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8.5.3.2 PROGRAM VERIFY DEVICE

要对器件编程，请选择 Program Verify Device 并按 <Enter>。该命令用器件编程器的
内部存储器 （镜像）对插座模块中的器件编程。

对于非闪存器件，器件编程器检查安装的单片机器件是否为空白。如果器件不是空白
的，器件编程器将询问是否要继续。回答 Yes 继续。回答 No 返回到命令菜单。

器件编程器将其存储器内容烧写到插座模块中安装的单片机中。如果十六进制文件未
装载到器件编程器中，将显示事件消息 “Valid image not present! Please download 
an image or use a master device before continuing.”（不存在有效镜像！请下载镜像
或使用主器件，再继续。）。器件编程器中必须存在镜像，才能对器件编程。要将十六
进制文件装载到 MPLAB PM3 中，必须将器件编程器连接到 PC，或从主器件读取。请
参见第 5.2.2 节 “将十六进制文件下载到 MPLAB PM3 存储器”。

对器件无错误编程后，器件编程器将执行检查，校验烧写到器件中的数据并返回校验
结果。对于安装的器件，器件编程器在非闪存器件的 VDD 最小值和 VDD 最大值或闪存
器件的 VDD 标称电压下执行校验。

器件编程器根据发生错误的位置报告编程错误和校验错误。将报告有关程序存储器、
配置位、 EEPROM 数据存储器和 ID 存储单元的错误。只显示每个区域内第一个未通
过的存储单元。将显示地址、期望值和读取值。

编程后，器件编程器显示校验和。

8.5.3.3 VERIFY DEVICE

要校验器件，选择 Verify Device 并按 <Enter>。器件编程器比较其内部存储器内容和
插座模块中安装的已编程单片机的内容。如果数据和配置位设置正确， LCD 上将显示
“PASSED!”和校验和。器件编程器在非闪存器件的 VDD 最小值和 VDD 最大值或闪存
器件的 VDD 标称电压下执行校验。器件编程器根据器件的哪部分未通过来报告错误。
只显示每个区域内第一个未通过的存储单元。将显示地址、期望值和读取值。

8.5.3.4 BLANK CHECK DEVICE

要执行空白检查，选择 Blank Check Device 并按 <Enter>。该检查将检查器件是否完
全空白 （所有位都设置为 1）并且所有配置位都设置为 1（未编程状态）。完成后，
编程器 LCD 显示 “Device Blank”（器件空白）。只显示每个区域未通过的第一个存
储单元。将显示地址、期望值和读取值。

OTP 器件不能擦除和再编程。

如果 EPROM 器件不是空白的，必须先擦除才能再编程，否则要选择其他器件。

1. 除去覆盖在器件窗口上的任何标签。如果不是窗口器件，就不能对它再编程。所
有 EPROM 器件的窗口版本可通过请求 JW 封装来订购。

2. 将器件放入紫外线 （UV） EPROM 擦除器中。完全擦除紫外线可擦除器件所需
的时间取决于：紫外线的波长、强度、到紫外线源的距离以及器件的工艺技术
（存储单元的尺寸）。
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3. 尝试对器件编程前，请再次执行空白检查以校验器件是空白的。

8.5.3.5 ERASE DEVICE

要擦除闪存器件，选择 All Functions>Erase Device，按 <Enter>。再按一次 <Enter>
擦除器件。完成时， LCD 显示 “Done.”（已完成。）。

8.5.3.6 DEVICE INFORMATION

要显示器件信息，选择 All Functions>Device Information，按 <Enter>。系统将显示器
件 ID、器件版本信息、上次校验和以及用户 ID。还包含 “Check Code Protect”（检
查代码保护）的选项。要检查该器件是否代码保护，按 <Enter>。

8.5.3.7 SETTINGS

要显示 Settings 选项，选择 All Functions>Settings，按 <Enter>。 Settings 选项包含
带有以下选项的子菜单：

• Pgm/Vfy Settings （编程 / 校验设置）

• ICSP Settings （ICSP 设置）

• Adjust Voltages （调节电压）

• Reset Voltages （复位电压）

• Reset Statistics Count （复位统计计数）

• Safe Mode （安全模式）

8.5.3.7.1 Pgm/Vfy Settings

• Memory Ranges （存储器范围）——显示从环境检索到的为器件选择的存储器范
围。

• Select Regions （选择区域）——针对程序存储器、 EEPROM、 ID 和配置位的编
程，切换 Yes/No 设置。

• Program Options （编程选项）——针对编程选项 “Erase before Pgm”（编程前
擦除）和 “Preserve EEPROM”（保护 EEPROM）切换 Yes/No 设置。

• Reset to Defaults （复位为默认）——恢复所选器件的默认范围、区域和选项设
置。

注： 如果器件是 EEPROM 或闪存，无需在再编程前擦除它。这些器件在编程
前会被电擦除。
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8.5.3.7.2 ICSP Settings

以下选项仅当所选器件支持 ICSP 时可用。

1. ICSP Power Source （ICSP 电源）——MPLAB PM3 显示当前 ICSP 电源并提
供两个选项：

• Power from MPLAB PM3（通过 MPLAB PM3 供电）——对器件编程时将
通过 MPLAB PM3 供电。

• Target has own supply （目标自带电源）——对器件编程时从目标自带
的电源供电。

2. ICSP Programming Mode （ICSP 编程模式）——MPLAB PM3 显示当前 ICSP
编程模式电压条件，并提供两个选项：

• MCLR High Voltage （MCLR 高电压）——使用 MCLR 高电压对器件编
程。

• PGM Pin (LVP) （编程引脚 （LVP））——使用低电压编程引脚对器件编
程。

8.5.3.7.3 Adjust Voltages

该选项允许您调节闪存器件的 VDD 标称、 VDD APP 和 VPP 值以及 EEPROM 器件的
VDD 最大值、 VDD 最小值、 VDD 标称值以及 VPP 值。

每个选项都会显示当前设置并让您选择 “Up”或 “Down”。每次按 <Enter>，电压
设置向上或向下调节 0.125。

8.5.3.7.4 Reset Voltages

要将电压复位，选择 All Functions>Settings>Reset Voltages 并按 <Enter>。该命令将
电压复位为默认设置。

8.5.3.7.5 Reset Statistics Count

要将编程统计信息复位，选择 All Functions>Settings>Reset Statistics Count 并按
<Enter>。该命令将把计数器复位为 0。

8.5.3.7.6 Safe Mode

安全模式的设计是为了防止生产中出现操作错误。在安全模式下，唯一可用的功能是
编程和校验。如果按下其他任何按钮，将显示一条消息，告诉您系统处于安全模式，
不允许该操作。MPLAB PM3 连接到 PC 上时，在 MPLAB IDE 中请求其他功能将取消
安全模式。

要进入安全模式，选择 All Functions>Settings>Safe Mode 并按 <Enter>。在安全模式
下，命令菜单上只有 Program 和 Verify 选项可用。实现安全模式后，将把系统处于安
全模式的信息传送给命令菜单。
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注：
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第 9 章  MPLAB PM3 卡参考信息

9.1 简介

本章说明如何在 MPLAB PM3 器件编程器中使用 MPLAB PM3 卡。 MPLAB PM3 卡可
通过 MPLAB IDE 软件或直接在独立模式的 MPLAB PM3 编程器中访问。本章只讨论
MPLAB PM3 卡专用的命令。关于其他 MPLAB IDE 命令，请参见第 7 章 “MPLAB 
PM3—MPLAB IDE 参考信息”。关于其他独立模式命令，请参见第 8 章“独立模式参
考信息”。

本章讨论的主题包括：

• MPLAB PM3 卡

• 通过 MPLAB IDE 访问 MPLAB PM3 卡

• 以独立模式使用 MPLAB PM3 卡

9.2 MPLAB PM3 卡

MPLAB PM3 卡是可插入 MPLAB PM3 编程器背面的 SD-MMC 端口中的存储器件
（见图 9-1）。该卡只能沿一个方向插入插槽。它可用于存储能够与 MPLAB PM3 编程
器相互传输的环境。

图 9-1： MPLAB® PM3 的后视图

请参见 Readme for MPLAB PM3.txt文件以查看 Microchip 测试过并推荐的存储卡
的列表。

9.3 通过 MPLAB IDE 访问 MPLAB PM3 卡

MPLAB IDE 的 Programmer 菜单包含用于 MPLAB PM3 卡的两个选项：

• Environment——显示可对该环境执行的操作的子菜单。

• MPLAB PM3 Card——显示有关 MPLAB PM3 卡的操作的子菜单。

I O

电源打开 关闭电源

电源输入 USB 端口

USB
RS-232

　 串口

PWR SD-MMC

安全数字 /
多媒体卡端口
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9.3.1 Environment

选择 Programmer>Environment 以显示子菜单选项 （图 9-2）。

图 9-2： ENVIRONMENT 子菜单

MPLAB IDE Programmer 菜单上的 Environment 选项提供可通过 MPLAB IDE 执行的
若干操作：

• Save
• Copy
• View
• Load
• Delete
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9.3.1.1 SAVE

该选项允许您将环境保存到 MPLAB PM3 卡、硬盘驱动器或其他位置。

选择 Programmer>Environment>Save 打开 Save Environment （保存环境）对话框
（图 9-3）并执行以下步骤：

图 9-3： SAVE ENVIRONMENT 对话框

1. 在 Environment Name 字段中，输入希望保存的环境的名称 （最多 127 个字
符）。

2. 如果在 Programmer>Settings>SQTP 对话框中为器件指定了 SQTP 文件，
SQTP 文件名将出现在 SQTP File 字段中。保存环境前，必须生成该文件并装载
到 MPLAB IDE 中。这是只显示的字段，不能在其中输入信息。

3. 在可选的 Misc. Files （Misc. 文件）字段中，单击 Browse 或输入文件名以添加
您希望随该环境保存的文件。如果输入文件名，必须指定完整路径。多个文件必
须用逗号隔开。一个环境中最多可以保存 10 个各种文件 （.txt 和 .hex 文件
等）。

4. 在可选的 Description 字段中，输入环境的简短说明。

5. 单击 Browse 打开 Environment Destination 窗口 （图 9-4）。必须使能 MPLAB 
PM3，才能使 MPLAB PM3 卡显示在 Environment Destination 窗口中。
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图 9-4： ENVIRONMENT DESTINATION 窗口

6. 选择 MPLAB PM3 Card 将环境保存到 MPLAB PM3 卡，或选择其他目标将它保
存到其他位置。单击 OK 关闭 Environment Destination 窗口并返回到 Save 
Environment 对话框。

7. 在 Save Environment 对话框中的 Destination 字段将显示所选位置。单击 Save
保存环境。单击 Close 关闭对话框。 Output 窗口将显示一条确认环境已保存的
消息。

9.3.1.2 COPY

该选项允许您创建环境的副本，您可以存储它、在其他位置使用它，或根据该环境创
建新的环境。

选择 Programmer>Environment>Copy 打开 Copy Environment （复制环境）对话框
（图 9-5）。该命令将环境从一个位置复制到另一个位置，例如从 MPLAB PM3 卡复制
到硬盘驱动器。用以下步骤复制环境：

图 9-5： COPY ENVIRONMENT 对话框

注： 为了保存环境， MPLAB PM3 卡必须插入到编程器中。
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1. 在 Environment Source （环境来源）字段中单击 Browse 打开 Select 
Environment （选择环境）窗口 （图 9-6）。

图 9-6： SELECT ENVIRONMENT 窗口

2. 找到并选择要复制的 *.pm3 文件并单击 OK。（您可能需要展开目录才能找到需
要的文件。） Select Environment 窗口关闭，您将返回到 Copy Environment 对
话框。该位置现在显示在 “Environment Source”字段中。

3. 在 Environment Destination 字段中单击 Browse 打开 Environment Destination
窗口 （图 9-4）。

4. 选择希望复制该环境的目标位置。单击 OK，然后单击 Close 返回到 Copy 
Environment 对话框。该位置现在显示在 “Environment Destination”字段中。

5. 单击 Copy 执行该操作，然后单击 Close。 Output 窗口中将显示一条消息，确
认已复制了环境。复制环境时，会复制环境文件和其他相关文件。将在目标目录
中创建和环境文件同名的文件夹，相关文件将放在其中。
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9.3.1.3 VIEW

用该选项在载入、复制或执行其他功能前查看环境。

选择 Programmer>Environment>View 打开 View Environment （查看环境）窗口
（图 9-7）。用该对话框查看或载入环境。

图 9-7： VIEW ENVIRONMENT 窗口

1. 选择要查看的环境 （*.pm3）并单击 OK。（您可能需要展开目录才能显示文
件。）系统将关闭 View Environment 窗口并显示所选环境 （请参见图 9-8 中的
示例）。

图 9-8： 查看环境的示例

2. 从这里单击 Close，或将查看的环境装载到 MPLAB IDE 并单击 Load。装载完
成后， Output 窗口中将显示消息。
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9.3.1.4 LOAD

该选项将把环境文件从 MPLAB PM3 卡载入 MPLAB PM3 编程器中。

选择 Programmer>Environment>Load 打开 Load Environment （载入环境）窗口
（图 9-9）。

图 9-9： LOAD ENVIRONMENT 窗口

展开该目录显示要载入 MPLAB IDE 中的 *.pm3 文件，并单击 OK。环境文件装载到了
MPLAB IDE 中，一条确认消息将显示在 Output 窗口中。
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9.3.1.5 DELETE

该选项从指定位置删除所选环境文件。如果删除环境文件后目录是空的，该目录也将
被删除。

选择 Programmer>Environment>Delete 打开 Delete Environment （删除环境）窗口
（图 9-10）。

图 9-10： DELETE ENVIRONMENT 窗口

展开该目录显示要从指定位置删除的 *.pm3 文件，并单击 OK。环境文件 （包括任何
相关文件）被删除，一条确认消息将显示在 Output 窗口中。如果删除环境文件后目录
是空的，该目录也将被删除。

9.3.2 MPLAB PM3 Card

MPLAB PM3 卡插入并且 MPLAB PM3 使能时，MPLAB IDE Programmer 菜单上将有
以下 MPLAB PM3 Card 选项可用：

• List Files
• Format
• Properties
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9.3.2.1 LIST FILES

该选项使您能查看环境中的所有文件，这样执行其他操作 （例如装载、复制或删除）
前就可以复查文件。

选择 Programmer>MPLAB PM3 Card>List Files 打开 List Files 窗口 （请参见图 9-11
中的示例）。展开目录显示所有文件。查看列表后单击 OK 或 Close。

图 9-11： LIST FILES 窗口

9.3.2.2 FORMAT

该选项将 MMC 卡格式化为 FAT16 格式。如果卡不是 FAT16 格式， LCD 屏幕上将显
示警告消息：

MPLAB PM3 only supports FAT16.
Would you like to format now as FAT16?
DATA WILL BE DESTROYED!

（MPLAB PM3 只支持 FAT16。现在要格式化成 FAT16 吗？数据将被删除！）

按 <ENTER> 重新格式化非 FAT16 卡。

对于 FAT16 卡， MPLAB PM3 卡插入编程器后，选择 Programmer>MPLAB PM3 
Card>Format 打开 Format PM3 Card （格式化 PM3 卡）对话框 （图 9-12）。

图 9-12： FORMAT PM3 CARD 对话框

单击 OK 继续格式化 MPLAB PM3 卡，或单击 Cancel。
格式化 MPLAB PM3 卡时，所有数据都将从卡中擦除。
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9.3.2.3 PROPERTIES

该选项将列出插入的 MPLAB PM3 卡的信息，包括容量、空闲字节数、已用字节数及
簇大小。

选择 Programmer>MPLAB PM3 Card>Properties 在 Output 窗口中显示属性 （请参见
图 9-13 中的示例）。

图 9-13： MPLAB® PM3 卡属性
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9.4 以独立模式使用 MPLAB PM3 卡

通过独立模式的 MPLAB PM3 编程器访问 MPLAB PM3 卡有两种模式：

• 通过主菜单中的 MPLAB PM3 Card 菜单

• 选择器件后通过 All Functions 菜单

9.4.1 MPLAB PM3 Card 菜单

在独立模式下，插入 MPLAB PM3 卡后，主菜单有若干选项：

• Recently Used （见第 8.4.1 节 “Recently Used”）
• Select Device （见第 8.4.2 节 “Select Device”）

• MPLAB PM3 Card
• Programmer Settings （见第 8.4.3 节 “Programmer Settings”）

• Help （见第 8.4.4 节 “Help”）
从主菜单选择 MPLAB PM3 Card 后，器件编程器将显示 MPLAB PM3 卡的命令菜单：

• Load an Environment
• View an Environment
• View Disk Contents
• Open a Text File
• Card Properties

命令菜单上的功能允许您执行对单片机编程的基本用户任务。重复按 <ESC> 可回到主
菜单。

9.4.1.1 LOAD AN ENVIRONMENT

Load an Environment 选项从 MPLAB PM3 卡将环境载入 MPLAB PM3 编程器中。环境
包括相关的 BIN 文件、存储器、电压、 ICSP 设置和可选的 SQTP 文件。

9.4.1.2 VIEW AN ENVIRONMENT

View an Environment 选项显示环境的内容和设置。只能用该选项查看环境。

9.4.1.3 VIEW DISK CONTENTS

View Disk Contents 选项显示插入 MPLAB PM3 编程器中的 MPLAB PM3 卡的内容。
目录 （用文件夹图标指定）可通过按 <ENTER> 键进一步展开。

9.4.1.4 OPEN A TEXT FILE

Open a Text File (*.txt) 选项显示文本文件的前几百个字符。

9.4.1.5 CARD PROPERTIES

显示卡的字节容量、空闲字节数、已用字节数和簇大小。

注： 独立模式下不使用编程范围、擦除选项和存储区域设置。
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9.4.2 All Functions 菜单

选择器件后，将显示器件的菜单：

• Program Verify Device （见第 8.5.1 节 “Program Verify Device”）
• Verify Device （见第 8.5.2 节 “Verify Device”）
• All Functions

插入 MPLAB PM3 卡时，All Functions 选项显示一个子菜单，其中的选项请见表 9-1。
请注意列表末尾 MPLAB PM3 卡的一个额外选项。有关列出的所有其他功能，请参见
第 8.5.3 节 “All Functions”。

MPLAB PM3 Card 功能显示以下选项：

表 9-1： ALL FUNCTIONS 菜单

选择 说明

Read Device 读取器件内容。有选择地读取 （例如部分程序存储器或仅器件的
配置位）可通过设置下面的 Settings 实现。

Program Verify Device 对器件进行编程及校验。

Verify Device 校验器件是否编程正确。

Blank check device 检查器件是否完全空白 （所有位都设置为 1）。还将检查所有配
置位是否都设置为 1（未编程状态）。

Erase Device 擦除 MPLAB® PM3 器件编程器中的器件。该选项仅对可擦除器
件显示。

Device Information 显示器件名、器件 ID、器件版本、上次校验和以及用户 ID。

MPLAB PM3 Card 显示 MPLAB PM3 卡操作的子菜单。

Settings 设置编程 / 校验选项、 ICSP™ 设置、调节电压、复位电压、复
位统计计数及安全模式。

表 9-2： MPLAB® PM3 CARD 功能
Load an Environment 从 MPLAB PM3 卡将环境载入 MPLAB PM3 编程器。

View an Environment View an Environment 选项显示环境的内容和设置。只能用该选
项查看环境。

Card Properties 显示卡的字节容量、空闲字节数、已用字节数和字节簇。
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附录 A 硬件规范

A.1 简介

本附录描述 MPLAB PM3 与 PC 的连接、编程器硬件和插座模块硬件。本附录的内容
包括：

• 通过串口连接 PC
• 编程器规范

• ICSP 硬件规范

• 插座模块规范

A.2 通过串口连接 PC
MPLAB PM3 通过带有 DB9 连接器的标准 RS-232 端口与 PC 连接。设备在默认情况
下使用 57.6K 波特率。

串口通信如下：

• 57.6K （默认值）或 9.6K 波特率 （仅 PROCMD）

• 8 个数据位， 1 个停止位，无奇偶校验位

• 硬件流控制

表 A-1 列出了用于将 MPLAB PM3 编程器 （9 引脚直通）连接到 25 引脚串口的数据。
连接表中各行指示的对应接线端。

表 A-1： PC 主机至 MPLAB® PM3 的信号

 25 引脚 （PC 主机）  9 引脚 （MPLAB PM3）
2 TX 2 RX
3 RX 3 TX

20 DTR 4 DTR
7 Common 5 Common
6 DSR 6 +5 伏（上拉）

4 RTS 7 CTS
5 CTS 8 RTS
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A.3 编程器规范

本节讨论以下主题：

• 物理尺寸和布局

• 一般规范

A.3.1 物理尺寸和布局

MPLAB PM3 器件编程器的物理尺寸为 8 3/8″ L x 6 5/16″ W x 13/16″ H。在图 A-1 和图
A-2 中分别显示了俯视图和后视图。

图 A-1： MPLAB® PM3 俯视图

图 A-2： MPLAB® PM3 后视图

注： 所指定的值针对的是正常的工作条件，代表推荐的工作条件。绝对最大额
定值目前尚未公布。

ESC ENTER

状态

电源

MPLAB®   PM3
器件编程器

ICSP 连接器

 插座模块连接器

LED

LCD

键 / 按钮

M

I O

打开电源 关闭电源

电源输入 USB 端口

USB
RS232

     串口

PWR SD-MMC

安全数字 /
多媒体卡端口
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A.3.2 一般规范

A.4 ICSP 硬件规范

本节包含：

• ICSP 插头和电缆引脚排列

• ICSP VDD/VPP 工作特性

• MPLAB PM3 Handler 工作特性

A.4.1 ICSP 插头和电缆引脚排列

MPLAB PM3 配有 ICSP 插头和电缆。您可以在插座模块的安装位置下找到该插头。在
图 A-3 （从 MPLAB PM3 上方俯视）中可找到插头配置，在表 A-3 中列出了电缆颜色
和信号名称。

图 A-3： ICSP 插头配置

表 A-2： 一般规范

组件 说明

电源 20.3W 双路输出：+3.3VDC/5A， +5.0VDC/0.75A ；具有 5 引脚 Mini Din
插头

USB 电缆 USB A-B M-M 电缆， 6 英尺

串行电缆 RS-232 DB9 （1 端为凸头， 1 端为凹头）

ICSP™ 电缆 18″ 15 引脚， 22 AWG Super Flex Stranded Series 200 接线，末端带有
2 x 7 芯线套管

引脚驱动器 40 引脚通用驱动器，可提供 VDD、 VPP、 I/O 和接地端

诊断 电源、 CPU、 FPGA 和 CPLD

表 A-3： ICSP™ 电缆引脚

引脚 颜色 信号

1 紫色 CLK
2 绿色 PASS
3 橙色 DATA
4 褐色 FAIL
5 白色 LVP/Clock
6 蓝色 GO
7 黄色 VPP

8 黄色 VPP

9 红色 VDD

10 白色 （带有蓝色条纹） Test
11 红色 VDD

12 灰色 +5V
13 黑色 GND
14 黑色 GND
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有关针对特定器件使用 ICSP 的信息在器件的编程规范中描述。您可以在 Microchip 网
站中找到这些编程规范。

A.4.2 ICSP VDD/VPP 工作特性

注： 因为 MPLAB PM3 具有内置的 ICSP，所以不能使用 PRO MATE II ICSP 插
座模块 （AC04004）和 MPLAB PM3-PRO MATE II 器件适配器。

表 A-4： 通过 MPLAB® PM3 供电

参数 值

VPP 范围 9-14V （步长为 125 mV）
IPP 范围 最大为 150 mA
VDD 范围 2-5.5V （步长为 125 mV）
IDD 范围 最大为 500 mA
保护 过压关断

表 A-5： 通过目标供电

参数 值

目标 VDD 范围 2-5.5V

VPP 范围 9-14V （步长为 125 mV）
IPP 最大为 -150 mA
目标 VDD 范围 2-5.5V

保护 IPP 过电流保险丝和过压关断

注： 不使用随 MPLAB PM3 设备提供的电缆而使用任何其他电缆 （其他材料、
长度 ...）可能会导致器件编程不可靠。
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A.4.3 MPLAB PM3 Handler 工作特性

表 A-6： ICSP™ I/O 工作特性

参数 条件 VDD 最小值 最大值

VDD 电源电压范围 2.00 5.50
VIH 最小高电平输入电压 2.0 1.50

3.0 2.10
5.5 3.85

VIL 最大低电平输入电压 2.0 0.50
3.0 0.90
5.5 1.65

VOH 最小高电平输出电压
@ IOH = -50 µA

2.0 1.90
3.0 2.90
4.5 4.40

VOL 最大低电平输出电压
@ IOL = 50 µA

2.0 0.10
3.0 0.10
4.5 0.10

IOH 高电平输出电流 2.00 -50 µA
3.3 -4 mA
5.0 -8 mA

IOL 低电平输出电流 2.00 -50 µA
3.3 -4 mA
5.0 -8 mA

tR, tF 上升 / 下降时间 50 nS
tPD 传播延迟 Cl = 50 pF 1 nS 5.5 nS

表 A-7： PASS/FAIL 信号

参数 条件 VCC 最小值 最大值

VOH 最小高电平输出电压
@ IOH = -5.2 mA

5.0 4.50

VOL 最大低电平输出电压
@ IOL = 5.2 mA

5.0 0.26

IOH 高电平输出电流 5.0 -20 mA
IOL 低电平输出电流 5.0 20 mA

表 A-8： GO 信号

参数 条件 VCC 最小值 最大值

VIH 最小高电平输入电压 5.0 3.50
VIL 最大低电平输入电压 5.0 1.50

注：  GO 信号在内部使用 10K 电阻上拉至 +5.0V，并通过 0.1 µF 电容连接至
GND。
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A.5 插座模块规范

本节讨论以下主题：

• 插座规范

• MPLAB PM3 插座模块插入

• 与 MPLAB PRO MATE II 插座模块的兼容性

• 插座寿命和清洁方法

• 典型编程时间

A.5.1 插座规范

表 A-9： 插座 VDD/VPP 工作特性

参数 值

VPP 范围 9-14V （步长为 125 mV）
IPP 范围 最大为 150 mA
VDD 范围 2-5.5V （步长为 125 mV）
IDD 范围 最大为 500 mA
保护 过电流关断

表 A-10： 插座 I/O 工作特性

参数 条件 VCC 最小值 最大值

VCC 电源电压范围 2.00 5.50
VIH 最小高电平输入电压 2.0 1.50

3.0 2.10
4.5 3.15
5.5 3.85

VIL 最大低电平输入电压 2.0 0.50
3.0 0.90
4.5 1.35
5.5 1.65

VOH 最小高电平输出电压
@ IOH = -50 µA

2.0 1.90

3.0 2.90
VOL 最大低电平输出电压

@ IOL = 50 µA
2.0 0.10

3.0 0.10
4.5 0.10

IOH 高电平输出电流 1.65 -4 mA
2.3 -8 mA
3.0 -24 mA
4.5 -32 mA

IOL 低电平输出电流 1.65 4 mA
2.3 8 mA
3.0 24 mA
4.5 32 mA
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A.5.2 MPLAB PM3 插座模块插入

MPLAB PM3 利用插座模块来兼容各种 Microchip 器件。MPLAB PM3 插座模块在编程
器上具有两个接口连接器 （图 A-4）。

图 A-4： 插座模块位置

A.5.3 与 MPLAB PRO MATE II 插座模块的兼容性

MPLAB PM3 可通过使用适配器模块连接 PRO MATE II 插座模块。

A.5.4 插座寿命和清洁方法

Microchip 使用多家制造商生产的插座模块。表 A-11 列出了制造商报告的每个插座模
块的寿命数据 （以自动插入的次数表示）和清洁方法。

A.5.4.1 制造商

所有插座 （Yamaichi 的除外）均标有制造商的名称。 Yamaichi 插座可通过在插座上
寻找字符串 IC51 （作为部件号的前缀）而辨别。

     插座模块

        编程器

警告

不要尝试将 PRO MATE II ICSP 插座模块连接到 MPLAB PM3。

表 A-11： 插座寿命和清洁方法

制造商 插入数 清洁方法

Aries 10,000 无

AMP （18 引脚） 25,000 无

3M Textool 10,000 甲醇

Yamaichi 25,000 甲醇



MPLAB® PM3 用户指南

DS51464C_CN 第 106 页  2006 Microchip Technology Inc.

A.5.4.2 插入数

手动插入的寿命会低于制造商报告的数据。手动插入的次数取决于插座状况和插座的
清洁频率。

插座插入不够小心或插座脏污会导致插入次数降低至 5,000 次以下。保持清洁以及在
将器件插入插座时保持小心对于表面安装器件最为重要，因为插座接触面必须保持平
坦，以确保正常工作。

接触面弯曲或不平坦会导致故障。如果器件是手动插入插座模块，则在插座模块使用
期间，会较早地出现插座模块接触面不平坦的现象。手动插入会较早地产生接触故障是
由于手动插入方法的不可重复性而导致的。因此，如果器件手动进行插入，则可能无
法达到所列出的插入次数。对于确保接触面平坦，不存在任何好的方法。

A.5.4.3 清洁方法——甲醇

使用甲醇进行清洁，然后使用干燥压缩空气对接触面进行吹风。

A.5.5 典型编程时间

表 A-12 显示了在以独立模式使用 MPLAB PM3 时的典型编程时间。通过 MPLAB IDE
进行编程时的结果可能会不同。

危险

甲醇极度易燃。请在通风良好区域使用甲醇，并确保该区域中没有火星、火苗或任何其他
点火源。甲醇具有毒性，吸入后可能会导致失明。请避免吸入甲醇挥发气体。

表 A-12： 以独立模式工作时的典型编程时间

器件 编程时间

PIC12F675 4 秒

PIC16F877A 5 秒

PIC16F819 4 秒

PIC18F452 7 秒

PIC16F88 3.7 秒

PIC16C55A 2.5 秒

PIC17C44 10 秒

PIC12C509 4 秒

PIC16F77 6.6 秒

PIC16F877 37 秒

PIC18F8720 24 秒
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附录 B 疑难解答

B.1 简介

本章中的疑难解答信息可帮助您解决在对单片机进行编程时遇到的问题或障碍。本附
录讨论的主题包括：

• 硬件疑难解答

• 操作问题疑难解答

• 软件疑难解答

• 常见问题

• 错误消息——PC
• 错误消息——LCD
• 限制

B.2 硬件疑难解答

一些涉及硬件的问题包括：

• 通信故障

• 确保插座模块正确接触

• 插座模块故障

B.2.1 通信故障

附录 A “硬件规范”中列出了用于将 MPLAB PM3 器件编程器连接到通信端口的数
据。如果发生通信故障，请检查通信端口。

B.2.2 确保插座模块正确接触

在更换插座之后，请插入空白器件并进行空白检查，以确保插座正确接触。空白器件
将显示为已擦除。未正确安装的模块插座将导致校验过程报告错误，指示错误数据为
全零 （0000）。

B.2.3 插座模块故障

如果您可以对主芯片进行编程，并且可以读取代码保护的芯片，但是在尝试对芯片进
行编程时失败，那么可能插座引脚已损坏。如果插座模块无法正常工作，请联系
Microchip 的应用工程师 （FAE）。
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B.3 操作问题疑难解答

涉及 MPLAB PM3 基本操作的问题包括：

• 在独立模式下读取主芯片

• 器件引脚损坏

B.3.1 在独立模式下读取主芯片

在独立模式下读取主芯片时，器件编程器会询问 “Code Protect Parts”，即是否对要
编程的器件进行代码保护。回答 Yes 将对要编程的器件进行代码保护。

B.3.2 器件引脚损坏

在较小的器件封装（SSOP、 PQFP 和 SOIC）上，引脚极易发生弯曲，从而导致在对
器件进行编程时发生问题。

B.4 软件疑难解答

一些涉及软件的问题包括：

• 与 MPLAB PM3 建立通信

• 看不到 MPLAB PM3 菜单

• 默认串口

• 需要更新操作系统

B.4.1 与 MPLAB PM3 建立通信

在使能编程器时， MPLAB IDE 会尝试与 MPLAB PM3 建立通信。如果无法建立通信，
则不会进行编程。如果尝试建立通信失败，将会显示一个对话框。如果遇到通信问题，
请查看以下信息。

B.4.1.1 串口通信

1. 对于 Windows 98 和 Windows 2000，在设置 COM 端口时需要特别注意。如果
怀疑驱动程序与硬件不兼容，请尝试将 “流控制”更改为 “硬件”和 / 或关闭
串口的 FIFO。此操作可以在 “控制面板”中完成。

在 Windows 98 中，单击 “系统”图标。单击设备管理器选项卡，然后单击端
口。（如需要）通过单击 “端口”选项旁的 “+”符号展开它。双击 MPLAB 
PM3 连接的 I/O 端口。此时您可以将流控制设置为 “硬件”。要关闭 FIFO，请
单击高级按钮，取消选择 “使用 FIFO 缓冲区”复选框，然后单击确定。重新启
动 PC。

2. 在 Windows 2000 中，单击 “系统”图标。单击硬件选项卡，然后单击设备管
理器按钮。（如需要）通过单击 “端口”选项旁的 “+”符号展开它。 双击
MPLAB PM3 连接的 I/O 端口。此时您可以将流控制设置为 “硬件”。要关闭
FIFO，请单击端口设置选项卡，然后单击高级按钮。取消选择 “使用 FIFO 缓
冲区”复选框，然后单击确定。重新启动 PC。

3. 请确保 RS-232 电缆已连接，电源线也已连接，并且 MPLAB PM3 上的电源开关
已打开。

4. 尝试将 MPLAB PM3 连接到其他串口。如果 PC 具有 25 引脚串口，则需要使用
25-9 串口适配器。
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5. 请确保 COM 端口正确设置为由 MPLAB PM3 专用。对资源进行检查，以确保它
们正常运行，并且与其他设备不存在任何冲突。当调制解调器或其他串口设备时
配置不当时经常会发生冲突。请参考 Windows 手册或其他参考资料。您可以尝
试除去、重新配置或禁用冲突设备，但前提是您必须非常熟悉这些过程。

6. 一些系统错误是由于驱动程序与硬件不兼容引起的。

7. 您必须使用当前所使用的 Microsoft Windows 版本自带的 Windows 通信驱动程
序。

8. 请确保使用的不是第三方通信驱动程序。打开 SYSTEM.INI文件，并在
[OPTIONS] 部分中查找具有以下内容的行

COMM.DRV=COMM.DRV

如果该行的内容与上面所示不同，则说明您使用的是其他通信驱动程序。

B.4.2 看不到 MPLAB PM3 菜单

如果您使用其他编程器 （例如， PICSTART Plus）， MPLAB PM3 菜单可能不可用。
选择 Programmer>Select Programmer 以打开 Select Programmer 对话框，然后从列
表中选择 MPLAB PM3。选择编程器之后， MPLAB IDE 将发出警告提示，并关闭。
只有重新启动 MPLAB IDE 之后，编程器选项才可用。 MPLAB IDE 重新启动后，
MPLAB PM3 菜单将显示在菜单栏上。

B.4.3 默认串口

首次运行 MPLAB PM3 时， MPLAB PM3 将使用 COM1 作为默认串口。如果使用
Programmer>Communications Port Setup 命令更改了串口选择，那么在下次运行
MPLAB PM3 时，主机软件将使用在上次会话中使用的同一端口。

B.4.4 需要更新操作系统

如果在 MPLAB IDE 中设置开发模式时选择的器件不受 MPLAB PM3 操作系统支持，
则在使能编程器时将会显示一个消息框。

请确保允许 MPLAB PM3 进行升级，以获取 MPLAB IDE 软件和 MPLAB PM3 操作系
统的最新版本 （第 7.8 节 “升级 MPLAB PM3 操作系统”）。
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B.5 常见问题

常见的问题包括：

• 无法与编程器建立通信

• 高级串行通信帮助

• 器件引脚损坏 （请参见第 B.3.2 节 “器件引脚损坏”）

• 看不到编程器选项 （请参见第 B.4.2 节 “看不到 MPLAB PM3 菜单”）

• 在 Programmer 菜单中 MPLAB PM3 Card 选项不可用

B.5.1 无法与编程器建立通信

在选择 Enable Programmer 时， MPLAB IDE 会尝试与编程器建立通信。如果无法
建立通信，则不会进行编程。如果尝试建立通信失败，则会在 Output 窗口中报告。

• 常规通信疑难解答

• 串行通信

• USB 通信

B.5.1.1 常规通信疑难解答

1. 检查 RS-232 或 USB 电缆是否可靠地连接到 MPLAB PM3 和主机。

2. 检查是否已连接电源，以及编程器上的电源 LED 是否点亮。

3. 请确保使用的不是第三方通信驱动程序。打开 SYSTEM.INI文件，并在
[OPTIONS] 部分中查找具有以下内容的行：

COMM.DRV=COMM.DRV

如果该行的内容与上面所示不同，则说明您使用的是其他通信驱动程序。

B.5.1.2 串行通信

1. Windows COM 端口设置需要特别注意。如果怀疑驱动程序与硬件不兼容，请尝
试将 “流控制”更改为 “硬件”和 / 或关闭串口的 FIFO。此操作可以在 “控制
面板”中完成。

在 Windows 98/ME 中，单击 “系统”图标。单击设备管理器选项卡，然后单击
端口。（如需要）通过单击 “端口”选项旁的 “+”符号展开它。双击编程器连
接的 I/O 端口。此时您可以将流控制设置为 “硬件”。要关闭 FIFO，请单击高
级按钮，取消选择 “使用 FIFO 缓冲区”复选框，然后单击确定。重新启动
PC，以使更改生效。

在 Windows NT 中，单击端口图标。选择 COM 端口，单击设置，然后单击高级
按钮。取消选择 FIFO 复选框，然后单击确定。重新启动 PC，以使更改生效。

在 Windows 2000/XP 中，单击 “系统”图标。单击硬件选项卡，然后单击设备
管理器按钮。（如需要）通过单击 “端口”选项旁的 “+”符号展开它。双击编
程器连接的 I/O 端口。此时您可以将流控制设置为 “硬件”。要关闭 FIFO，请
单击端口设置选项卡，然后单击高级按钮。取消选择 “使用 FIFO 缓冲区”复选
框，然后单击确定。重新启动 PC，以使更改生效。
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2. 请确保 COM 端口正确设置为由编程器专用。对资源进行检查，以确保它们正常
运行，并且与其他设备不存在任何冲突。通常在另一个设备未正确配置的时发生
冲突。请参考 Windows 手册或其他参考资料。您可以尝试除去、重新配置或禁
用冲突设备，但前提是您必须非常熟悉这些过程。

3. 一些系统错误是由于驱动程序与硬件不兼容引起的。

4. 尝试将编程器连接到其他串口。如果 PC 具有 25 引脚串口，则您需要使用 25-9
串口适配器。

5. 检查器件是否正确插入演示板 / 目标应用板；例如，是否所有引脚都已插入插座
且器件方向正确。

更多信息，请参见第 B.5.2 节 “高级串行通信帮助”。

B.5.1.3 USB 通信

1. 请确保使用的是 MPLAB IDE 为 MPLAB PM3 提供的 USB 驱动程序。

2. 确保在 Programmer>Settings Communications 选项卡中选择了 USB。

B.5.2 高级串行通信帮助

以下是一些可能导致问题的方面：

• 调制解调器交互

• 关于串行鼠标的问题

• 中断冲突

• 第三方通信驱动程序

• 手动设置端口

B.5.2.1 调制解调器交互

编程器不能使用与调整解调器相同的通信端口和中断。您可以尝试在软件中禁用调制
解调器、将其中一个移动到不同的通信端口，或者除去调制解调器。

B.5.2.2 关于串行鼠标的问题

如果使用的是串行鼠标，请确保不要在无意中将鼠标的通信端口指定为编程器端口。

B.5.2.3 中断冲突

确保系统中不存在中断冲突。也即，确保每个中断都只由一个设备使用。

在 Windows 98/ME 中，从 “开始”菜单选择设置 > 控制面板。选择系统，然后单击
设备管理器选项卡。展开 “端口”选项，确保不存在冲突指示符。

在 Windows NT/2000/XP 中，从 “开始”菜单选择设置 > 控制面板。选择系统，然后
双击端口。在列表中单击 COM 端口，然后单击设置。在 “设置”对话框中，单击高
级。确保不存在 IRQ 冲突。

警告

如果 Windows 操作系统已选择了 USB 驱动程序，则 MPLAB PM3 将不工作，并且您将

无法安装正确的驱动程序。
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B.5.2.4 第三方通信驱动程序

编程器设计为使用随 Windows 操作系统提供的驱动程序运行。第三方驱动程序可能工
作也可能不工作。检查 SYSTEM.INI文件。在 [OPTIONS] 下，应当存在具有以下内
容的行：

COMM.DRV=COMM.DRV

如果该行的内容与上面所示不同，则说明您使用的是第三方驱动程序。

B.5.2.5 手动设置端口

在某些系统中，编程器无法设置通信端口。端口必须手动进行设置。

在 Windows 98/ME 中，从 “开始”菜单选择设置 > 控制面板。选择系统，然后单击
设备管理器选项卡。展开 “端口”选项，然后双击要使用的端口。单击端口设置选项
卡，然后选择 57600 波特率、8 个数据位、无奇偶校验位、1 个停止位和硬件流控制。
单击高级。取消选择 “使用 FIFO 缓冲区”复选框。某些系统具有与此相关的问题。
重新启动 PC，以使更改生效。

在 Windows NT 中，从 “开始”菜单选择设置 > 控制面板。选择系统，然后双击 “端
口”。在列表中单击 COM 端口，然后单击设置。在 “设置”对话框中，选择 57600
波特率、 8 个数据位、无奇偶校验位、 1 个停止位和硬件流控制。单击高级，然后取消
选择 “使用 FIFO 缓冲区”复选框。重新启动 PC，以使更改生效。

在 Windows 2000/XP 中，单击系统图标。单击硬件选项卡，然后单击设备管理器按
钮。（如需要）通过单击 “端口”选项旁的 “+”符号展开它。双击编程器连接的 I/O
端口。此时您可以将流控制设置为 “硬件”。要关闭 FIFO，请单击端口设置选项卡，
然后单击高级按钮。取消选择 “使用 FIFO 缓冲区”复选框，然后单击确定。重新启
动 PC，以使更改生效。

B.5.3 在 Programmer 菜单中 MPLAB PM3 Card 选项不可用

要使 MPLAB IDE Programmer 菜单中的 MPLAB PM3 Card 选项可用，必须将 MPLAB 
PM3 卡插入 MPLAB PM3 编程器，打开编程器的电源，并且通过 MPLAB IDE 使能编
程器。如果所使用的卡不受支持，那么在菜单中将不会显示 MPLAB PM3 Card。（关
于推荐使用的卡列表，请参见 Readme for MPLAB PM3.txt。）
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B.6 错误消息——PC
以下是可能接收到的一些错误消息：

• Could Not Open the Communications Port （无法打开通信端口）

• USB Communication Could Not Be Established （无法建立 USB 通信）

• Device is Code-Protected （器件受代码保护）

• Parity Error Found in Program Memory （在程序存储器中发现奇偶校验错误）

• Program Memory Contains Code-Protected Data （程序存储器中含有代码保护的
数据）

• Invalid Checksum （校验和无效）

B.6.1 Could Not Open the Communications Port

如果无法打开通信端口，则原因可能是另一个应用程序已打开了该端口，或者该端口
不存在。请确保端口号有效，并且没有其他应用程序正在使用它，例如 MPLAB IDE 的
另一个实例。

B.6.2 USB Communication Could Not Be Established

在使能使用 USB 的 MPLAB PM3 时，如果 MPLAB PM3 设备的电源快速地关闭又打
开，或者电源临时中断，要重新建立 USB 通信，您必须：

• 确保 MPLAB PM3 电源开关已关闭。

• 取消选择MPLAB PM3作为当前编程器（Programmer>Select Programmer>None）。
• 重新打开 MPLAB PM3 的电源。

• 重新选择 MPLAB PM3 作为编程器 （Programmer>Select Programmer> MPLAB 
PM3）。

• 使能 MPLAB PM3 编程器（Programmer>Enable Programmer）。等待 10 秒钟，以
便 Windows 识别它。如果这不起作用，请重新启动 PC 或尝试连接到不同的 USB
根集线器。

B.6.3 Device is Code-Protected

如果尝试读取代码保护的器件，则将显示该警告。请从文件或非保护器件获取原始的
十六进制代码。另请参见第 B.6.5 节“Program Memory Contains Code-Protected 
Data”。

B.6.4 Parity Error Found in Program Memory

一些器件使用一个配置位来请求计算奇偶性。当该位设置为 “ON”时，器件将会对程
序存储器的内容进行比较，并将奇偶性指定为 “偶”或 “奇”。设置为 “OFF”时，
器件不会执行比较。

在空白器件中，奇偶校验配置位默认设置为 “ON”。如果在进行编程时，器件的奇偶
校验配置位设置为 “ON”，则每次对器件再编程都可能会导致显示奇偶校验错误。出
现这种情况是因为检测到当前的奇偶性与上次编程时的奇偶性不匹配。但是，接收到奇
偶校验错误并不会停止对器件进行编程。

不过，如果在对器件进行编程时将奇偶校验位设置为 “OFF”，则不会对程序存储器
内容的奇偶性进行比较。此时无论奇偶性如何，对器件进行再编程都不会接收到消息。

所有 OTP 器件，包括那些具有奇偶校验配置位的器件，都无法成功地将任何位值 0再
编程为 1。如果在对器件进行编程时将奇偶校验配置位设置为 “OFF”，则无法将奇
偶校验重新设置为 “ON”。此时必须使用空白器件。
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B.6.5 Program Memory Contains Code-Protected Data

程序存储器中含有从代码保护器件读取的数据。该数据的大部分或全部不可用。请从
文件或非保护器件获取原始的十六进制代码。另请参见第 B.6.3 节 “Device is 
Code-Protected”。

B.6.6 Invalid Checksum

该错误表示在尝试从编程器读取数据时发生硬件问题。这不是一个非常常见的错误。
它通常说明 PC 或编程器上的通信硬件存在某种问题。

B.7 错误消息——LCD

B.7.1 BIOS 错误

表 B-1： MPLAB® PM3 蜂鸣代码

鸣叫
次数

含义 修正操作

1 正常启动 无需任何操作。

2 CPLD 未配置 复位并连接到 MPLAB IDE。
3 未找到电源监视器 复位并连接到 MPLAB IDE。
4 屏无显示 复位设备。如果问题依然存在，请联系现

场代表对设备进行 SAR。

5 显示屏读写测试失败 复位设备。如果问题依然存在，请联系现
场代表对设备进行 SAR。

6 FPGA 超时 复位设备。如果问题依然存在，请联系现
场代表对设备进行 SAR。
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表 B-2： BIOS 错误代码

错误
代码

定义 修正操作

1 CPLD 未配置 复位并连接到 MPLAB® IDE。
2 CPLD 已旧 复位并连接到 MPLAB IDE。
3 缺少闪存 复位设备。如果问题依然存在，请联系现场代表

对设备进行 SAR。

4 闪存访问不正确 复位设备。如果问题依然存在，请联系现场代表
对设备进行 SAR。

5 FPGA 配置已超时 复位并连接到 MPLAB IDE。
6 缺少 FPGA 镜像 复位并连接到 MPLAB IDE。
7 FPGA 已旧 复位并连接到 MPLAB IDE。
8 未找到电源监视器 复位并连接到 MPLAB IDE。
9 电源监视器已旧 复位并连接到 MPLAB IDE。

10 未找到 ICSP™ 监视器 复位并连接到 MPLAB IDE。
11 ICSP 监视器已旧 复位并连接到 MPLAB IDE。
12 子板上发生故障 复位设备。如果问题依然存在，请联系现场代表

对设备进行 SAR。

13 未找到 USB 复位并连接到 MPLAB IDE。
14 USB 已旧 复位并连接到 MPLAB IDE。
15 屏无显示 复位设备。如果问题依然存在，请联系现场代表

对设备进行 SAR。

16 存储器故障 复位设备。如果问题依然存在，请联系现场代表
对设备进行 SAR。

17 未找到操作系统 复位并连接到 MPLAB IDE。
18 VDD 电流过高 如果是使用插座模块进行编程，请检查是否选择

了正确的部件，以及部件是否正确插入插座。

19 VPP 电流过高 如果是使用插座模块进行编程，请检查是否选择
了正确的部件，以及部件是否正确插入插座。

20 操作系统已旧 复位并连接到 MPLAB IDE。
24 缺少时钟 复位设备。如果问题依然存在，请联系现场代表

对设备进行 SAR。

25 显示屏读写失败 复位设备。如果问题依然存在，请联系现场代表
对设备进行 SAR。

26 电源监视器无法升压 确保目标已从 MPLAB PM3 断开连接，并重试。
如果通过了，则检查 ICSP 接线。如果再次失
败，请联系现场代表对设备进行 SAR。 

27 更新失败 关闭设备。检查与 PC 的连接。确保选择了适当
的端口并安装了正确的驱动程序。重新启动并重
试。
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B.7.2 其他错误消息

• Hardware needs to be reconfigured.Please attach to PC and connect through 
MPLAB IDE to update [error number]  BIOS needs to download a newer version 
of some firmware. （需要对硬件重新进行配置。请接到 PC 并通过 MPLAB IDE 进
行连接，以更新 [ 错误号 ]——BIOS 需要下载一些固件的较新版本。）

• Fatal Error:Hardware not found.Contact your local field office for assistance [error 
number]  Cannot read a piece of hardware. （严重错误：未找到硬件。请联系当
地的销售办事处以获取帮助 [ 错误号 ]——无法读取一个硬件。）

• Fatal Error:Memory Failure.Contact your local field office for assistance.[error 
number]  Memory test failed. （严重错误：存储器故障。请联系当地的销售办事处
以获取帮助。 [ 错误号 ]——存储器测试失败。）

B.7.3 LCD 版本屏幕

系统启动时，将会显示版本屏幕。

Bios Version………………………………………………[ver]
OS Version……………………………………………………[ver]
Supervisor Version………………………………[ver]
Memory Controller Version……………[ver]
HS Shifter Version………………………………[ver]
Daughter Board Version……………………[ver]
USB EEPROM Version………………………………[ver]
Database Version……………………………………[ver]
    No Calibration Required!

B.8 限制

B.8.1 一般限制

• 请查看 “Readme for MPLAB PM3.txt”文件来了解当前支持的器件。

• 不受代码保护的程序存储器范围只能从1更改为0。大多数器件都需要先进行擦除，
然后才能再编程。 DataEE 在进行编程之前不需要进行擦除；不过，它每次编程一
个存储单元。有关更多信息，请参考器件的具体编程规范。

• 一些器件每次对多个存储单元进行编程。因而，MPLAB PM3 会禁止与这些边界不
对齐的编程范围。有关更多信息，请参见具体的编程规范。

B.8.2 特定于器件的限制

除了以上列出的一般限制之外，一些 PICmicro MCU 可能还具有特定于器件的限制。
请选择下面列出的器件系列限制，或者在索引中搜索您的器件。

B.8.2.1 对于 PIC18C601/801 的 MPLAB PM3 限制

• 对于这些无 ROM 器件，您必须使用自己的存储器读 / 写程序。

B.8.2.2 对于所有器件的 MPLAB PM3 限制

• 对于 ICSP，除了VDD和VSS引脚之外，您还必须连接AVDD和AVSS引脚，这样才能
对器件进行编程。
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术语表

ANSI

美国国家标准学会，是美国负责制订和批准的组织。

ASCII

美国信息交换标准码是使用 7 个二进制数字来表示每个字符的字符集编码。它包括大
写和小写字母、数字、符号以及控制字符。

Build

编译并链接一个应用的所有源文件。

编译器 （Compiler）
将用高级语言编写的源文件翻译成机器码的程序。

C

具有表达式简练、现代控制流程和数据结构，以及运算符丰富等特点的通用编程语言。

COFF

公共目标文件格式。这种格式的目标文件包含机器码、调试及其他信息。

操作符 （Operator）
在构成定义明确的表达式时使用的符号，例如加号 “+”和减号 “-”。每个操作符都
具有指定的优先级，用于确定求值的顺序。

操作码 （Opcode）
操作码。参见助记符。

程序存储器 （Program Memory）
器件中存储指令的存储器。亦指仿真器或软件模拟器中包含下载的目标应用固件的存
储器。

程序计数器 （Program Counter）
包含正在执行的指令的地址的存储单元。

触发输出 （Trigger Output）
指可在任意地址或地址范围产生的仿真器输出信号，与跟踪和断点的设置无关。可设
置任意个触发输出点。

次数计数器 （Pass Counter）
每次一个事件 （如执行特定地址处的一条指令）发生时都会递减 1 的计数器。当次数
计数器的值为零时，事件满足。可将次数计数器分配给断点和跟踪逻辑，以及在
complex trigger （复杂触发）对话框中的任何连续事件。

带序列号的快速批量编程 （Serialized Quick Turn Programming）
序列化使您可以在器件编程器进行编程的每个单片机中写入序列号。该编号可用作记
录码、密码或 ID 号。
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单片机 （Microcontroller）
高度集成的芯片，它包括 CPU、 RAM、程序存储器、 I/O 端口和定时器。

单片机模式 （Microcontroller Mode）
PIC17CXXX 和 PIC18CXXX 系列单片机的一种程序存储器配置。在单片机模式下，仅
允许内部执行。因此，在这种模式下仅可使用片内程序存储器。

导出 （Export）
以标准的格式将数据发送出 MPLAB IDE。
导入 （Import）
从外面的源 （如 HEX 文件）将数据送入 MPLAB IDE。
递归 （Recursion）
已定义的函数或宏可调用自己的概念。当编写递归宏时要特别小心；当递归没有出口
时容易陷入无限循环。

地址 （Address）
标识存储器中位置的值。

断点，软件 （Breakpoint, Software）
一个地址，固件会在这个地址处暂停执行。通常由特殊的 break 指令获得。

断点，硬件 （Breakpoint, Hardware）
一个事件，执行这种事件会导致暂停。

堆栈，软件 （Stack, Software）
用来存储返回地址、函数参数和局部变量的存储区。当用高级语言开发代码时，该存
储区一般由编译器管理。

堆栈，硬件 （Stack, Hardware）
PICmicro 单片机中调用函数时存储返回地址的存储区。

EEPROM

电可擦除的可编程只读存储器。一种可电擦除的特殊 PROM。一次写或擦除一个字
节。 EEPROM 即使电源关闭时也能保留内容。

EPROM

可擦除的可编程只读存储器。通常通过紫外线照射来擦除的可编程只读存储器。

FNOP

强制空操作。强制 NOP周期是双周期指令的第二个周期。由于 PICmicro 单片机的架
构是流水线型，在执行当前指令的同时预取物理地址空间中的下一条指令。如果当前
指令改变了程序计数器，那么这条预取的指令就被忽略了，导致一个强制 NOP周期。

仿真 （Emulation）
象执行存储在单片机中的固件一样执行装入仿真存储区中的软件的过程。

仿真存储器 （Emulation Memory）
仿真器内部的程序存储器。

仿真器 （Emulator）
执行仿真的硬件。
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仿真器系统 （Emulator System）

MPLAB ICE 2000 和 4000 仿真器系统包括仿真器主机、处理器模块、器件适配器、电
缆和 MPLAB IDE 软件。

仿真器主机 （Pod, Emulator）
包含仿真存储区、跟踪存储区、事件和周期定时器，以及跟踪 / 断点逻辑的仿真器盒
子。

非实时 （Non Real-Time）
指处理器执行到断点或单步执行指令，或 MPLAB IDE 运行在软件模拟器模式。

非易失性存储器 （Nonvolatile Storage）
电源关闭时保留其内容的存储器件。

符号 （Symbol）
描述组成程序的不同部分的一种通用机制。这些部分包括函数名、变量名、段名、文
件名和结构 / 枚举 / 联合标记名等。 MPLAB IDE 中的符号主要指变量名、函数名和汇
编标号。链接后符号的值就是其在存储器中的值。

GPR

通用寄存器。器件数据存储器 （RAM）的一部分，作为一般用途。

高级语言 （High-Level Language）
编写程序的语言，它比汇编语言更不依赖于具体的处理器。

跟踪 （Trace）
记录程序执行的仿真器或软件模拟器功能。仿真器将程序执行记录到其跟踪缓冲区内，
并可上载到 MPLAB IDE 的跟踪窗口中。

跟踪存储区 （Trace Memory）
跟踪存储区包含在仿真器内部。跟踪存储区有时称为跟踪缓冲区。

工具条 （Tool Bar）
一行或一列图标，单击这些图标时将执行 MPLAB IDE 功能。

观察变量 （Watch Variable）
调试会话期间可在 Watch 窗口中监控的变量。

归档 （Archive）
可重定位目标模块的集合。由将多个源文件编译 / 汇编为目标文件，然后使用归档器将
目标文件组合为一个库文件生成。可将库与目标模块和其他库链接，生成可执行代码。

归档器 （Archiver）
生成和操作库的工具。

国际标准化组织 （International Organization for Standardization）
制订许多行业和技术 （包括计算和通讯）方面的标准的一个组织。

HEX 代码 （HEX Code）
以十六进制格式代码存储的可执行指令。 HEX 代码包含在 HEX 文件中。

HEX 文件 （HEX File）
包含适用于对器件编程的十六进制地址和值 （HEX 代码）的 ASCII 文件。
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宏 （Macro）
宏指令。以缩写形式表示指令序列的指令。

宏伪指令 （Macro Directive）
控制宏定义体中执行和数据分配的伪指令。

环境 （Environment）
当前编程设置的快照。它包含重新创建当前编程状态的所有必需信息，包括到器件存
储器文件、可选 SQTP 文件和特定部件信息的链接。

汇编器 （Assembler）
把汇编源代码翻译成机器码的语言工具。

汇编语言 （Assembly Language）
以符号形式描述二进制机器码的符号语言。

ICD

在线调试器。 MPLAB ICD 和 MPLAB ICD 2 分别是 Microchip 用于 PIC16F87X 和
PIC18FXXX 器件的在线调试器。这些 ICD 与 MPLAB IDE 配合使用。

ICE

在线仿真器。 MPLAB ICE 2000 和 4000 是 Microchip 与 MPLAB IDE 配合使用的在线
仿真器。

IDE

集成开发环境。 MPLAB IDE 是 Microchip 的集成开发环境。

IRQ

参见中断请求。

ISO

参见国际标准化组织。

ISR

参见中断服务程序。

激励 （Stimulus）
软件模拟器的输入 （即为模拟对外部信号的响应而生成的数据）。通常数据采用文本
文件中一系列动作的形式。激励可以是异步的，同步的 （引脚），时钟激励和寄存器
激励。

机器码 （Machine Code）
处理器实际读和解释的计算机程序的表示。二进制机器码的程序由一系列机器指令
（可能还包含数据）组成。特定处理器的所有可能指令的集合称为 “指令集”。

机器语言 （Machine Language）
特定中央处理单元的指令集，不需翻译即可用于处理器。

基数 （Radix）
数字基，十六进制或十进制，用于指定一个地址。

交叉引用文件 （Cross Reference File）
引用符号表的一个文件及引用符号的文件列表。如果定义了符号，列出的第一个文件
是定义的位置。其他文件包含对符号的引用。
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校准存储区 （Calibration Memory）
用于保存 PICmicro 单片机片内 RC 振荡器或其他外设校准值的特殊功能寄存器或通用
寄存器。

节点 （Node）
MPLAB IDE 项目的组件。

警告 （Warning）
提醒出现了可能导致器件、软件文件或设备物理损坏的通知。

静态 RAM 或 SRAM （Static RAM or SRAM）

静态随机访问存储器。目标板上可读 / 写且不需要经常刷新的程序存储器。

局部标号 （Local Label）
用 LOCAL伪指令在一个宏内部定义的标号。这些标号特定于宏实例化的一个给定示
例。也就是说，声明为 local 的符号和标号在遇到 ENDM宏后不再可访问。

绝对段 （Absolute Section）
具有链接器不能改变的固定 （绝对）地址的段。

看门狗定时器 （Watchdog Timer）
PICmicro 单片机中在一段可选择长度的时间后复位处理器的定时器。使用配置位来使
能、禁止和设置 WDT。
控制伪指令 （Control Directive）
汇编语言代码中根据汇编时指定表达式的值包含或忽略代码的伪指令。

库 （Library）
参见归档。

库管理器 （Librarian）
参见归档器。

快速存取存储区 （Access Memory，仅 PIC18）
PIC18XXXXX 单片机中的一些特殊寄存器，对这些寄存器的访问与存储区选择寄存器
（BSR）的设置无关。

扩展单片机模式 （Extended Microcontroller Mode）
在扩展单片机模式下，既可使用片内程序存储器，也可使用外部存储器。如果程序存储
器地址大于 PIC17CXXX 或 PIC18CXXX 器件的内部存储空间，执行自动切换到外部
存储器。

链接描述文件 （Linker Script File）
链接器的命令文件。定义链接选项并描述目标平台上的可用存储器。

链接器 （Linker）
把目标文件和库文件组合起来生成可执行代码并解析一个模块对另外一个模块引用的
语言工具。

列表伪指令 （Listing Directive）
控制汇编器列表文件格式的伪指令。它们允许指定标题、分页及其他列表控制。

列表文件 （Listing File）
列出为每条 C 源语句生成的机器码、源文件中遇到的汇编指令、汇编器伪指令或宏的
ASCII 文本文件。
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逻辑探头 （Logic Probe）
Microchip 的某些仿真器最多可连接 14 个逻辑探头。逻辑探头提供外部跟踪输入、触
发输出信号、 +5V 和公共接地端。

Make 项目 （Make Project）
重新编译应用程序的命令，仅编译自上次编译完成后更改了的源文件。

MCU

单片机。 microcontroller 的缩写形式；也写作 µC。

MPASM 汇编器 （MPASM Assembler）
PICmicro 单片机、 KEELOQ® 器件及 Microchip 存储器件的 Microchip 可重定位宏汇编
器。

MPLAB ASM30

Microchip 用于 dsPIC30F 数字信号控制器器件的可重定位宏汇编器。

MPLAB C1X

请参考 Microchip 的 MPLAB C17 和 MPLAB C18 C 编译器。 MPLAB C17 是用于
PIC17CXXX 器件的 C 编译器， MPLAB C18 是用于 PIC18CXXX 和 PIC18FXXXX 器
件的 C 编译器。

MPLAB C30

Microchip 用于 dsPIC30F 数字信号控制器件的 C 编译器。

MPLAB ICD 2

Microchip 用于 PIC16F87X、 PIC18FXXX 和 dsPIC30FXXXX 器件的在线调试器。
ICD 与 MPLAB IDE 配合工作。每个 ICD 的主要组件是模块。一个完整的系统包括模
块、适配头、演示板、电缆和 MPLAB IDE 软件。

MPLAB ICE 2000

Microchip 用于 PICmicro MCU 且与 MPLAB IDE 配合工作的在线仿真器。

MPLAB ICE 4000

Microchip 用于 dsPIC DSC 且与 MPLAB IDE 配合工作的在线仿真器。

MPLAB IDE

Microchip 的集成开发环境。

MPLAB LIB30

MPLAB LIB30 归档器 / 库管理器是目标库管理器，用于将由 MPLAB ASM30 或
MPLAB C30 C 编译器生成的 COFF 目标模块组合为库文件。 
MPLAB LINK30

MPLAB LINK30 是 Microchip MPLAB ASM30 汇编器和 Microchip MPLAB C30 C 编译
器的目标连接器。

MPLAB PM3

Microchip 的生产编程器，与 MPLAB IDE 配合工作，支持 PICmicro MCU 器件。可与
MPLAB IDE 配合使用或独立使用。

MPLAB SIM

Microchip 的软件模拟器，与 MPLAB IDE 配合工作，支持 PICmicro MCU 器件。

MPLAB SIM30

Microchip 的软件模拟器，与 MPLAB IDE 配合工作，支持 dsPIC DSC 器件。
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MPLIB 目标库管理器 （MPLIB Object Librarian）
MPLIB 库管理器是用于将由 MPASM 汇编器 （mpasm 或 mpasmwin v2.0）或
MPLAB C1X C 编译器生成的 COFF 目标模块组合成库文件的目标库管理器。

MPLINK 目标链接器 （MPLINK Object Linker）
MPLINK 链接器是 Microchip MPASM 汇编器和 Microchip MPLAB C17 或 C18 C 编译
器的目标链接器。也可将 MPLINK 链接器与 Microchip MPLIB 库管理器配合使用。
MPLINK 链接器设计为在 MPLAB IDE 中使用，尽管它也可独立于 MPLAB IDE 使用。

MRU

最近使用的。指可从 MPLAB IDE 主下拉菜单选择的文件和窗口。

命令行接口 （Command Line Interface）
仅基于文本输入和输出，在程序和其用户之间进行通讯的一种方式。

模板 （Template）
为以后插入自己的文件中使用而创建的文本行。MPLAB 编辑器将模板存储到模板文件
中。

目标 （Target）
指用户硬件。

目标板 （Target Board）
构成目标应用的电路和可编程器件。

目标处理器 （Target Processor）
目标应用板上的单片机。

目标代码 （Object Code）
由编译器或汇编器生成的机器码。

目标文件 （Object File）
包含机器码，也可能包含调试信息的文件。它可以直接执行；或为可重定位的，需要
与其他目标文件 （如库文件）链接来生成完全可执行的程序。

目标文件伪指令 （Object File Directive）
仅当生成目标文件时使用的伪指令。

目标应用程序 （Target Application）
目标板上的软件。

NOP

空操作。执行该指令时，除了程序计数器加 1 外没有任何其他影响。

内部链接 （Internal Linkage）
如果不能从定义函数或变量的模块外部访问它们，则这样的函数或变量具有内部链接。

OTP

可一次编程。非窗口封装的 EPROM 器件。由于 EPROM 需要紫外线照射来擦除其存
储内容，因此只有窗口片是可擦除的。

PC

个人计算机或程序计数器。

PC 主机 （PC Host）
运行有一个支持的 Windows 操作系统的任何 IBM 或兼容个人计算机。
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PICmicro MCU

PICmicro 单片机 （MCU）指 Microchip 的所有单片机系列。

PICSTART Plus

Microchip 器件的开发编程器。可对 8、 14、 28 和 40 引脚的 PICmicro 单片机进行编
程。必须与 MPLAB IDE 软件配合使用。

PRO MATE II

Microchip 的器件编程器。可对所有 PICmicro 单片机、大多数存储器和 Keeloq 器件进
行编程。可与 MPLAB IDE 配合使用或单独使用。

PWN 信号 （PWM Signal）
脉冲宽度调制信号。某些 PICmicro MCU 包含 PWM 外设。

跑表 （Stopwatch）
测量执行周期的计数器。

配置位 （Configuration Bit）
可编程来设置 PICmicro 单片机工作模式的专用位。配置位可或不可再编程。

片外存储器 （Off-Chip Memory）
指 PIC17CXXX 或 PIC18CXXX 器件的一种存储器选择，这种情况下存储器可位于目
标板上，或所有程序存储器都由仿真器提供。从 Options> Development Mode 访问
Memory 选项卡可打开 Off-Chip Memory Selection 对话框。

器件编程器 （Device Programmer）
用于对电可编程半导体器件 （如单片机）进行编程的工具。

嵌套深度 （Nesting Depth）
宏可包含其他宏的最大深度。

RAM

随机访问存储器 （数据存储器）。可以以任意顺序访问这种存储器中的信息。

ROM

只读存储器 （程序存储器）。不能修改的存储器。

Run

将仿真器从暂停状态释放，允许仿真器实时运行应用代码、实时改变 I/O 状态或实时
响应 I/O 的命令。

软件模拟器 （Simulator）
模仿器件操作的软件程序。

SFR

参见特殊功能寄存器。

Shell

MPASM 汇编器 shell 是宏汇编器的提示输入接口。有两个 MPASM 汇编器 shell：一个
针对 DOS 版本，一个针对 Windows 版本。

Single Step

这一命令单步执行代码，一次执行一条指令。执行每条指令后， MPLAB IDE 更新寄存
器窗口、通过查看变量及状态显示，可分析和调试指令。也可单步执行 C 编译器源代
码，但不是每次执行一条指令，MPLAB IDE 将执行一行高级 C 语句生成的所有汇编指
令。
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Skew

不同时间出现在处理器总线上与指令执行有关的信息。例如，执行前一条指令的过程中
取指时，被执行的操作码出现在总线上；当实际执行该操作码时，源数据地址及其值
以及目标数据地址出现在总线上。当执行下一条指令时，目标数据值出现在总线上。
跟踪缓冲区一次捕捉总线上的这些信息。因此，跟踪缓冲区的一条记录将包含三条指
令的执行信息。执行一条指令时，从一条信息到另一条信息的捕捉周期数称为 skew。

Skid

当使用硬件断点来暂停处理器时，在处理器暂停前可能再执行一条或多条指令。断点
后执行的指令条数称为 skid。
SQTP

参见序列化快速编程。

Step Into

这一命令与 Single Step 相同。 Step Into （与 Step Over 相对）在 CALL指令后，单步
执行子程序。

Step Over

Step Over 允许调试代码时不单步执行子程序。当 step over 一条 CALL指令时，下一
个断点将设置在 CALL指令后的下一条指令处。如果由于某种原因，子程序陷入无限
循环或不正确返回，下一个断点将永远执行不到。除了对 CALL指令的处理外， Step 
Over 命令与 Single Step 相同。

闪存 （Flash）
按块 （而不是按字节）写或擦除数据的一种 EEPROM。

上电复位仿真 （Power-on-Reset Emulation）
在开始应用上电时，将随机值写到数据 RAM 区中来模拟 RAM 中的未初始化值的软件
随机过程。

上载 （Upload）
上载功能将数据从一个工具，如仿真器或编程器，传送到主机 PC，或将数据从目标板
传送到仿真器。

实时 （Real-Time）
当从仿真器或 MPLAB ICD 模式下的暂停状态释放时，处理器以实时模式运行且与芯
片的正常操作相同。在实时模式下，使能 MPLAB ICE 的实时跟踪缓冲区，并持续捕捉
所有选择的周期，使能所有 break 逻辑。在仿真器或 MPLAB ICD 模式下，处理器实时
运行，直到有效断点导致暂停，或者直到用户暂停仿真器。在软件模拟器模式下，实
时仅意味着单片机指令的执行速度与主机 CPU 可模拟的指令速度一样快。

事件 （Event）
对可能包含地址、数据、次数计数、外部输入、周期类型 （取指和读 / 写）及时间标
记的总线周期的描述。事件用于描述触发、断点和中断。

数据存储器 （Data Memory）
在 Microchip MCU 和 DSC 器件中，数据存储器 （RAM）由通用寄存器（GPR）和特
殊功能寄存器 （SFR）组成。某些器件还有 EEPROM 数据存储器。

数据伪指令 （Data Directive）
指控制汇编器的程序和数据存储空间分配，并提供通过符号 （即有意义的名字）引用
数据项的方法的伪指令。
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特殊功能寄存器 （Special Function Register）
数据存储器 （RAM）的一部分，专用于控制 I/O 处理函数、 I/O 状态、定时器或其他
模式及外设的寄存器。

Watch 窗口 （Watch Window）

Watch 窗口包含一系列观察变量，这些变量在每次执行到断点时更新。

WDT

参见看门狗定时器。

外部 RAM （External RAM）

片外的读 / 写存储器。

外部标签 （External Label）
具有外部链接的标签。

外部符号 （External Symbol）
具有外部链接的标识符符号。这可能是一个引用或一个定义。

外部符号解析 （External Symbol Resolution）
链接器搜集所有输入模块的外部符号定义来解析所有外部符号引用的过程。没有相应
定义的任何外部符号引用都会导致报告链接器错误。

外部链接 （External Linkage）
如果可以在定义函数或变量的模块外部对函数或变量进行引用，则函数或变量具有外
部链接。

外部输入线 （External Input Line）
用于根据外部信号设置事件的外部输入信号逻辑探针线 （TRIGIN）。

微处理器模式 （Microprocessor Mode）
PIC17CXXX 和 PIC18CXXX 系列单片机的一种程序存储器配置。在微处理器模式下，
不使用片内程序存储器。整个程序存储器映射到外部。

伪指令 （Directive）
源代码中控制语言工具操作的语句。

未初始化数据 （Uninitialized Data）
定义时未指定初始值的数据。在 C 中，

int myVar; 

定义了将存放到未初始化数据段的一个变量。

文件寄存器 （File Register）
片内数据存储器，包括通用寄存器 （GPR）和特殊功能寄存器 （SFR）。

系统窗口控制 （System Window Control）
系统窗口控制位于窗口或某些对话框的左上角。单击这一控制通常会弹出包含
Minimize （最小化）、 Maximize （最大化）和 Close （关闭）等项的菜单。

下载 （Download）
数据从主机发送到其他设备，如仿真器、编程器或目标板的过程。

限定符 （Qualifier）
次数计数器使用的地址或地址范围，或用作复杂触发中另一个操作之前的事件。
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项目 （Project）
为应用编译目标代码和可执行代码的一组源文件及指令。

消息 （Message）
显示出来的文本，警告在语言工具的操作中可能存在的问题。消息不会停止操作。

样机系统 （Prototype System）

指用户目标应用或目标板的一个术语。

异步激励 （Asynchronous Stimulus）
使用软件模拟器时，为模拟被软件模拟器件的外部输入而生成的数据。

应用 （Application）
可由 PICmicro 单片机控制的一组软硬件。

源代码 （Source Code）
编程人员编写计算机程序的形式。采用某种正式的编程语言编写源代码，可翻译为机
器码或被解释程序执行。

源文件 （Source File）
包含源代码的 ASCII 文本文件。

原始数据 （Raw Data）
与一个断有关的代码或数据的二进制表示。

暂停 （Halt）
停止程序执行。执行 Halt 与在断点处停止相同。

指令 （Instruction）
告知中央处理单元执行特定操作，并包含操作中要使用的数据的位序列。

指令集 （Instruction Set）
特定处理器理解的机器语言指令的集合。

中断 （Interrupt）
传递到 CPU 的信号，它使 CPU 暂停执行正在运行的应用程序，把控制权转交给中断
服务程序 （ISR），以处理事件。

中断处理程序 （Interrupt Handler）
发生中断时处理特殊代码的子程序。

中断服务程序 （Interrupt Service Routine）
当产生中断时进入的用户生成代码。代码在程序存储器中的位置通常取决于所产生中
断的类型。

中断请求 （Interrupt Request）
使处理器暂停正常的指令执行并开始执行中断处理程序的事件。某些处理器有几种中
断请求事件，允许具有不同优先级的中断。

助记符 （Mnemonic）
可直接翻译为机器码的文本指令。也称作操作码。

状态条 （Status Bar）
状态条位于 MPLAB IDE 窗口的底部，表明光标位置、开发模式和器件，以及有效工具
条等当前信息。
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字母数字字符 （Alphanumeric）
字母数字字符由字母字符和十进制数字 （0,1, …, 9）组成。

字母字符 （Alphabetic Character）
字母字符指属于阿拉伯字母表 （a, b, …, z, A, B, …, Z）中字母的字符。
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